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Вступ 
Тривимірне зображення відрізняється від плоского побудовою 

геометричної проекції тривимірної моделі сцени на екрані комп’ютера за 
допомогою спеціалізованих програм. 

Програми для створення 3D-графіки дозволяють створювати об'ємні 
моделі реальних і абстрактних об'єктів. 

Найчастіше тривимірна графіка застосовується для створення зображень в 
архітектурній візуалізації, кінематографі, телебаченні, комп’ютерних іграх, 
науці. 

Лідерами в галузі 3D-графіки є пакети 3ds Max, Maya, Lightwave 3D, 
SoftImage XSI, Sidefx Houdini, Maxon Cinema 4D тощо. 

Пакет Blender є відкритим кросплатформним продуктом, поширюваним 
вільно, і дозволяє робити виробництво моделей і подальший рендерінг. 

Основні поняття тривимірної графіки 
Для одержання тривимірного зображення на площині потрібні наступні 

кроки: 
• Моделювання - створення тривимірної математичної моделі сцени і об'єктів в 
ній. 
• Рендеринг (візуалізація) - побудова проекції відповідно до обраної фізичної 
моделі. 
• Виведення отриманого зображення на пристрій виведення - дисплей або 
принтер. 

 Сцена - це віртуальний простір моделювання. 
Сцена включає в себе кілька категорій об'єктів: 

• Геометрія об'єкта (побудована за допомогою різних технік модель); 
• Матеріали (інформація про візуальні властивості моделі, наприклад колір  і 
текстуру поверхонь); 
• Джерела світла (напрямок, потужність, спектр освітлення); 
• Віртуальні камери (вибір точки та кута побудови проекції); 
• Сили та дії (налаштування динамічних перетворень об'єктів); 
• Додаткові ефекти (об'єкти, що імітують реальні візуальні явища: світло у 
тумані, хмари, полум'я і пр.). 

Завдання тривимірного моделювання - описати об’єкти і розмістити їх на 
сцені за допомогою геометричних перетворень відповідно до вимог до 
майбутнього зображення. 

1. Інтерфейс Користувача – User Interface: 
При старті Blender у центрі його вікна з’являється екран заставки – splash 

screen. Він містить опції для створення нових проектів або відкриття нещодавно 
відкритих blend-файлів. Більш детальний опис можна знайти нижче. 

Для закриття екрана заставки та стартування нового проекту клацніть 

будь-де поза екраном заставки (але всередині вікна Blender’а) або натисніть Esc . 

Екран заставки зникне, залишивши стандартний екран. 
To reopen the splash screen click on the Blender icon in the Topbar and 

select Splash Screen. 
Регіон Інформації – Information Region 
Верхня частина екрана заставки містить зображення заставки з великою 



кількістю накладеної ключової інформації. 
Назва – Title 
Окрім іконки та тексту «Blender» показує також версію Blender’а. 

наприклад, поточна версія – 2.82. 
Дата – Date 
У верхньому правому кутку ви можете бачити дату, коли Blender було 

скомпільовано. 
Хеш – Hash 
Хеш Гіт-репозиторію – Git Hash. Це може бути корисним для отримання 

особистої підтримки при діагностуванні проблеми у роботі. 

 
Екран заставки – Splash Screen у Blender’і. 
Гілка – Branch 
Факультативно ім’я гілки. 
Інтерактивний Регіон – Interactive Region 
Інтерактивний регіон є у нижній половині екрана заставки. 
Новий Файл – New File 
Починається новий проект на основі шаблона. 
Недавні Файли – Recent Files 
Ваші зовсім нещодавно відкриті blend-файли. Це дає швидкий та легкий 

доступ до ваших недавніх проектів. 
Відкриття – Open 
Дозволяє відкривання наявного blend-файлу. 
Відновити Останню Сесію – Recover Last Session 
Blender спробує відновити останню сесію, базуючись на тимчасових 

файлах. Дивіться – Відновлення даних – Recovering Data. 
Посилання – Links 
Посилання на офіційний веб сайт. Ці ж самі посилання можна знайти 

у Меню «Довідка» – Help Menu верхньої смуги Topbar. 



 
Вікно програми Blender 2.69 
Для встановлення української мови інтерфейсу слід виконати 

послідовність дій: 
 File —> User Preferences —> вкладка System. 
 Встановити прапорець на параметрі International Fonts. 
 Обрати мову. Вказати, для яких параметрів буде використовутися 

обрана мова (Interface (Інтерфейс), Tooltips (Підказки), New Date (Дані). 
Вікно програми Blender складється з 5 областей. 

 
 
Info Editor (інформаційний редактор) — синій колір. 
3D View (3D-вигляд сцени) — жовтий колір. У цій області ми бачимо сітку, 

призначену для орієнтації у просторі. 
Timeline (часова шкала) — фіолетовий колір. 
Outliner (редактор проекта) — червоний колір. В цій області об'єкти сцени 

можна виділяти, змінювати назви, видимість, сортувати по колекціях тощо. 
Properties editor (редактор властивостей) — зелений колір. 
У головному вікні ми бачимо сцену, що складається з куба, лампи і камери 

(вид зверху). 



Куб - це стандартний меш-об'єкт. 
Лампа - створена, щоб висвітлити сцену. 
Камера - це точка зору користувача, і потрібна для того, щоб було звідки 

дивитися на сцену. 
 
Mesh-об'єкти є одним з типів об'єктів Blender. Mesh-об'єкти також 

називають сітками, полісітками. Це тривимірні геометричні примітиви, 
змінюючи які за допомогою базових трансформацій та інших модифікаторів, 
створюють інші, зазвичай більш складні, фігури. 

Керувати виглядом об'єкта можна за допомогою клавіш цифрової 
клавіатури: 

 
Навігація в 3D-вікні здійснюється мишкою і кнопками NumPad 

(Додаткової цифрової клавіатурі). 
Мишка виконує велику кількість функцій. Лівою Кнопкою Миші (ЛКМ) 

можна переміщати 3D-курсор, розтягувати вікна і виділяти об'єкти. 
Розташування 3D-курсора визначає місце створення нових об'єктів. Права 
кнопка використовується для вибору об'єктів або вершин (в режимі 
редагування). Коліщатко миші служить двом цілям. Прокрутка збільшує або 
зменшує масштаб відображення (як і клавіші "+" і "–" на цифровій клавіатурі). 
Натиснувши на коліщатко, можна обертати вид відображення. А 
утримування коліщатка в поєднанні з Shift дозволить панорамувати (Рухати) вид 
зображення. 

Для створення нового файлу слід виконати команду Файл / Новий / 
General. 

Для відкриття .blend-файлу слід виконати команду Файл / Open. 
Команда Файл /Append виконує додавання об'єкта (лампи, камери, 

матеріалу і т.д.) з іншого файлу Blender в поточну сцену. 
Команда Файл /Link додає об'єкт зі збереженням зв'язку з джерелом 

(об'єкт-джерело і доданий об'єкт змінюються паралельно). 



До версії 3.9 при закритті вікна Blender не запитував підтвердження або 
діалогу збереження сцени. 

Для збереження .blend-файлу слід виконати команду Файл / Save. 
Якщо ти випадково закриєш вікно без збереження, можна відновити 

останній сеанс командою Файл / Відновлення / Last Session. 
Якщо планується відкривати файл .blend на іншому комп’ютері, слід 

виконати команду  File / External Data  / Pack into .Blend file  (Пакування 
Даних). При виконанні цієї команди файли текстур і аудіо будуть додані до 
файлу .blend, і його можна без втрат відкрити на іншому комп’ютері. Для 
зменшення розміру файлу можна виконати зворотну операцію командою File / 
External Data / Unpack Data. 

 

2. Верхня смуга – Topbar. 
Меню – Menus 

Меню Застосунку – App Menu 
Екран Заставки – Splash Screen 

Відкривається Екран Заставки – Splash Screen. 
Підтримати Blender – Support Blender 
Фонд Розробки – Development Fund 

Відкривається вебсайт фонду розробників. 
Сховище Blender – Blender Store 

Відкривається сховище Blender’а. 
Про – About 

Примітки Випуску – Release Notes 
Відкриваються примітки щодо найостаннішого випуску. 

Вебсайт Blender’а – Blender Website 
Відкривається головний вебсайт Blender’а. 

Подяки – Credits 
Відкривається вебсайт подяк. 

Ліцензія – License 
Відкривається вебсайт Ліцензії. 

Інсталювати Шаблон Застосунку – Install Application Template 
Інсталюється новий шаблон застосунку – application template. 

 
Меню «Файл» – File Menu 

Опції для управління файлами: 

Нове – New Ctrl-N  

Зчищає поточну сцену та завантажує вибраний шаблон застосунку. 

Відкриття – Open Ctrl-O  

Open – відкриває blend-файл. 

Відкрити Недавнє – Open Recent Shift-Ctrl-O  

Показує список недавно – recently збережених blend-файлів для відкриття. 
Вертання – Revert 
Перевідкриває поточний файл в його останньо збереженій версії. 
Відновлення – Recover 



Відновити Останню Сесію – Recover Last Session 
Це завантажить blend-файл, який Blender автоматично зберігає перед 

самим виходом. Таким чином, ця опція дозволяє вам відновити 
– recover останню сесію вашої роботи, наприклад, якщо ви закрили Blender 
випадково. 

Відновити Авто Збереження – Recover Auto Save 
Це відкриє автоматично збережений файл для його відновлення – recover. 

Збереження – Save Ctrl-S  

Save – зберігає поточний blend-файл. 

Зберегти Як – Save As… Shift-Ctrl-S  

Відкриває Браузер Файлів – File Browser для вказування імені та 
розміщення збереження – save. 

Зберегти Копію – Save Copy… 
Saves – зберігає копію поточного файлу. 
Пов’язання – Link… 
Пов’язує дані із зовнішнього blend-файлу (бібліотеки) у поточну сцену. 

Редагування цих даних доступне тільки у зовнішній бібліотеці. Пов’язання 
– Link та Прилучення – Append використовується для завантаження лише 
вибраних частин з іншого файлу. See Linked Libraries. 

Прилучення – Append… 
Прилучає дані із зовнішнього blend-файлу у поточну сцену. Нові дані 

копіюються із зовнішнього файлу та повністю відв’язуються від останнього. 
Передогляди Даних – Data Previews 
Засоби для управління передоглядами блоків даних – data-block previews. 
Імпорт – Import 
Blender може використовувати інформацію, збережену у різних, інших 

форматів, файлах, що створені іншими програмами графіки. 
Дивіться Import/Export. 

Експорт – Export 
Зазвичай, ви зберігаєте вашу роботу у blend-файл, але ви можете 

експортувати деяку її частину або усю вашу роботу у формат, що може 
оброблятися іншими програми графіки. Дивіться Import/Export. 

Зовнішні Дані – External Data 
Зовнішні дані, як зображення текстур та інші ресурси, можуть бути 

збережені як всередині blend-файлу (запаковано) або як окремі файли 
(розпаковано). Blender простежує усіх розпаковані ресурси через відносний або 
абсолютний шлях. Дивіться pack or unpack external Data. 

Автоматично Упаковувати У .blend – Automatically Pack Into .blend 
Ця опція активує упаковування у файл. Якщо вона увімкнена, то кожен раз 

при збереженні blend-файлу, усі зовнішні файли будуть збережені всередині 
(запаковані) у ньому. 

Упакувати Все У .blend – Pack All Into .blend 
Упаковує усі використані зовнішні файли в цей blend-файл. 
Розпакувати У Файли – Unpack Into Files 
Розпаковує усі файли, запаковані у цьому blend-файлі, у зовнішні файли. 
Зробити Усі Шляхи Відносними – Make All Paths Relative 



Робить усі шляхи до зовнішніх файлів відносними – Відносні Шляхи – 
Relative Paths до поточного blend-файлу. 

Зробити Усі Шляхи Абсолютними – Make All Paths Absolute 
Робить усі шляхи до зовнішніх файлів абсолютними. Абсолютний шлях – 

це повний шлях з кореня системи. 
Повідомити про Відсутні Файли – Report Missing Files 
Ця опція корисна для перевірки на наявність посилань на розпаковані 

файли, що більше не існують. Після вибору цієї опції з’являється повідомлення 
з попередженням у заголовку редакторів Інфо. Якщо жодних попереджень не 
показується, то і відсутні такі пропущені зовнішні файли. 

Знайти Відсутні Файли – Find Missing Files 
У випадку, коли ми маємо розірвані посилання у blend-файлі, ця опція 

допомагає виправити цю проблему. Відкривається Браузер Файлів. «File 
Browser»Виберіть бажаний каталог (або файл у межах такого каталогу) і буде 
здійснено пошук у ньому, рекурсивно по всіх вкладених каталогах. Шляхи до 
кожного пропущеного файлу, знайдені при такому пошуку, буде відновлено. Ці 
відновлення будуть здійснені, як абсолютні шляхи, а тому, якщо ви хочете мати 
відносні шляхи, то вам необхідно скористатися командою «Зробити Усі Шляхи 
Відносними» – Make All Paths Relative. 

Вичищення – Clean Up 
Прочистити Усе – Purge All 
Вилучаються всі невикористовувані блоки даних з файлу (не може бути 

скасовано). Дивіться детальніше Outliner. 
Стандарти – Defaults 
Це меню управляє запусковим файлом, який використовується для 

збереження стандартної сцени, робпростору та інтерфейсу, що показується 
створюванні нового файлу. 

Первинно це містить запускову сцену – startup scene, включену разом з 
Blender’ом. Це може бути замінено вашим власним кастомізованим укладом. 

Зберегти Запусковий Файл – Save Startup File 
Зберігає поточний blend-файл як запусковий файл. 
Завантажити Заводські Устави – Load Factory Settings 
Відновлює стандартні запусковий файл та уподобання. 

Вихід – Quit Ctrl-Q  

Закриває Blender та файл зберігається у quit.blend . 

Меню «Редагування» – Edit Menu 
Скасування/Відновлення/Історія – Undo/Redo/History 
Дивіться Скасування та Відновлення – Undo & Redo. 
Пошук Оператора – Operator Search 
Виконується оператор на основі його імені. 
Перейменувати Активний Елемент – Rename Active Item 
Перейменовується активний об’єкт або вузол, дивіться детальніше Rename 

tool. 
Пакетне Перейменування – Batch Rename 
Перейменовує кілька одночасно типів даних за раз, дивіться 

детальніше Batch Rename tool. 



Блокувати Режими Об’єкта – Lock Object Modes 
Обмежується вибір поточним режимом. 
Уподобання – Preferences 
Відкривається вікно Preferences. 

Меню «Рендер» – Render Menu 

Рендер Зображення – Render Image F12  

Рендериться активна сцена у поточному кадрі. 

Рендер Анімації – Render Animation Ctrl-F12  

Рендериться анімація активної сцени. 
Рендер Аудіо – Render Audio 
Змішується файл аудіо зі сцени у файл звуку. 

Огляд Рендера – View Render F11  

Перемикається показ огляду рендера. 

Огляд Анімації – View Animation Ctrl-F11  

Програється рендерена анімація в окремому програвачі. 
Режим Показу – Display Mode 
Повний Екран – Full Screen 
Зображення рендеряться у максимізованому Редакторі Зображень – Image 

editor. 
Редактор Зображень – Image Editor 
Зображення рендеряться у Редакторі Зображень. 
Нове Вікно – New Window 
Зображення рендеряться у новому вікні. 
Утримати Інтерфейс Користувача – Keep User Interface 
Зображення рендеряться без зміни інтерфейсу користувача. 
Блокувати Інтерфейс – Lock Interface 
Блокує інтерфейс у ході рендерингу, щоб надати більше пам’яті для 

рендерера. 
Меню «Вікно» – Window Menu 

Нове Вікно – New Window 
Створюється нове вікно шляхом копіювання поточного вікна. 
Нове Головне Вікно – New Main Window 
Створюється нове вікно з його власним робпростором та вибором сцени. 
Перемкнути Повноекранний режим Вікна – Toggle Window Fullscreen 
Перемикається поточне вікно на повний екран. 
Наступний Робпростір – Next Workspace 
Перемикається на наступний робпростір. 
Попередній Робпростір – Previous Workspace 
Перемикається на попередній робпростір. 
Показ Смуги Статусу – Show Status Bar 
Обирається, чи смуга статусу – Status Bar внизу вікна повинна 

показуватися. 
Зберегти Екранознімок – Save Screenshot 
Захоплюється картинка активної області всього вікна Blender’а. 

Меню «Довідка» – Help Menu 



Дивіться Система Довідки – Help System. 
Робпростори – Workspaces 
Цей набір вкладок використовується для вибору поточного робпростору 

– Workspace; які по суті є передвизначеними розставами вікон. 
Сцени та Шари – Scenes & Layers 
Ці data-block menus використовуються для вибору поточно активних сцени 

– Scene шару огляду – View Layer. 
 

3. Робпростори – Workspaces. 
Workspaces – робпростори є по суті передвизначені розстави вікон. 

Гнучкість Blender’а з областями – Areas дозволяє вам створювати кастомізовані 
робпростори для різних завдань, таких як моделювання, анімування та 
скриптування. Часто корисно швидко перемикатися між різними робпросторами 
у межах одного і того ж файлу. 

Робпростори розміщуються на Верхній смузі – Topbar. 
3.1. Керувальники – Controls 
Вкладки – Tabs 

Клацайте на назвах вкладок для перемикання між робпросторами. Для 

обходження по робпросторам використовуйте Ctrl-PageUp  та Ctrl-PageDown . 

Подвійне клацання дозволяє перейменувати робпростір. 

Додання – Add +  

Клацайте на кнопці Add для додання нового робпростору. 

Контекстне меню – Context menu RMB  

Контекстне меню містить опції для дублювання, видалення та 
перевпорядкування робпросторів. 

Стандартні Робпростори – Default Workspaces. 
При стандартному запуску Blender’а показується робпростір «Layout» – 

«Розстава» у головній області. Цей робпростір є загальним робпростором для 
передогляду вашої сцени й об’єктів та містить наступні Редактори – Editors: 

 3D Огляд – 3D View зверху зліва. 
 Структуратор – Outliner зверху справа. 
 Редактор Властивостей – Properties Editor знизу справа. 
 Часолінія – Timeline знизу зліва. 
 
Blender також має кілька інших робпросторів, доданих стандартно: 

Моделювання – Modeling 
Для модифікації геометрії засобами моделювання. 

Ліплення – Sculpting 
Для модифікації сітей засобами ліплення. 

Редагування UV – UV Editing 
Розкладання координат текстур зображення на 3D поверхні. 

Малювання Текстур – Texture Paint 
Засоби для забарвлення текстур зображення у 3D Огляді. 

Відтінення – Shading 
Засоби для визначення властивостей матеріалів для рендерингу. 



Анімація – Animation 
Засоби для роблення властивостей об’єктів залежно від часу. 

Рендеринг – Rendering 
Для переглядання та аналізування результатів рендерингу. 

Компонування – Compositing 
Комбінування та після-оброблення зображень та інформації рендерингу. 

Скриптування – Scripting 
Робпростір програмування для написання скриптів. 
 
Blender має ряд додаткових Робпросторів - Additional Workspaces для 

обирання при доданні нового Робпростору: 
2D Анімація – 2D Animation 

Загальний робпростір для роботи з Нарисним Олівцем – Grease Pencil. 
2D Полотно Повністю – 2D Full Canvas 

Подібно до «2D Animation», але містить більше полотно. 
Візуальні Ефекти – VFX 
Маскування – Masking 

Засоби для створення 2D масок для компонування. 
Відстеження Руху – Motion Tracking 

Засоби для відстеження руху та стабілізації фільмоматеріалу. 
Редагування Відео – Video Editing 

Послідовність разом з медіа в одне відео. 
Збереження і заміщення – Save and Override 

Робпростори зберігаються у blend-файлі. Коли ви відкриваєте файл, 
увімкнення «Завантажувати Інтерфейс Користувача» – Load UI у Браузері 
Файлів – File Browser вказує, що Blender повинен використовувати розстави 
екрану з цього файлу і замістити ними поточну розставу. Дивіться Load UI. 

Кастомний набір робпросторів може бути збережено як частину стандартів 
– Стандарти – Defaults. 

 
3.2. Смуга Статусу – Status Bar. 
Смуга Статусу розміщується у самому низу вікна Blender’а та 

використовується для представлення інформації. Смуга Статусу може бути 
схована шляхом перетягування її вниз або від Меню «Вікно» – Window Menu. 

Смуга Статусу. 
Інформація Розкладки клавіш – Keymap Information 
Регіон лівої сторони Смуги Статусу показує інформацію про те, які кнопки 

миші або клавіші призначені для кожного редактора, режиму та засобу, і він 
оновлюється, як ви утримуєте натисненими модифікаційні клавіші. 

У редакторах зі смугою засобів натискування Alt  показує скорочення для 

змінення на бажаний засіб. 
Повідомлення Статусу – Status Messages 
Регіон у середній частині Смуги Статусу показує інформацію про завдання 

або засоби, що поточно виконуються. 
Виконувані Завдання – Running Tasks 



Смуга поступу та кнопка касування показуються під час здійснення 
триваліших завдань обчислення, таких як рендеринг або запікання. Наведення 
вказівника миші над нею показує оцінку часу на цю операцію. 

Повідомлення Звіту – Report Message 
Ярлик для оператора для показу результатів або попереджень. Він зникає 

через деякий час. Клацання на іконці зліва повідомлення звіту відкриє редактор 
інфо Info Editor, який показує повне повідомлення. 

Інформація Ресурсів – Resource Information 
Регіон у правій частині Смуги Статусу показує інформацію про поточний 

blend-файл. 
Активна Колекція – Active Collection 
Показує ім’я поточно вибраної колекції – Collection. 
Активний Об’єкт – Active Object 
Показує ім’я поточно вибраного об’єкта. 
Геометрія – Geometry 
Показує інформацію про поточно завантажену сцену, залежно від режиму 

та типу об’єкта. Коли показуються два числа, то перше описує рахунок 
вибраного, а друге – рахунок загалом. Це може бути кількість вершин, граней, 
трикутників (трибічників) або кісток. 

Об’єкти – Objects 
Показує кількість вибраних об’єктів. 
Пам’ять – Memory 
Ярлик «Mem» показує розраховану використану пам’ять Blender’ом. Це 

може допомогти ідентифікації, коли ви досягаєте лімітів вашого апаратного 
забезпечення. 

Версія Blender’а – Blender version 
Цей ярлик показує версію Blender’а. 

4. Області – Areas. 
Вікно Blender’а поділяється на ряд прямокутників, що називаються 

Області – Areas. Області резервують простір екрану для редакторів – Редактори 
– Editors, таких як 3D Оглядвікно – 3D Viewport або Структуратор – Outliner. 
Загалом Редактор забезпечує спосіб огляду та модифікування вашої роботи через 
певну частину Blender’а. Усі скорочення, які ви натискаєте, впливатимуть на 
вміст цього Редактора в Області, де розміщується вказівник миші. Рубежі 
областей позначаються округлими (скошеними) кутками. 

 
Рубежі областей позначаються округлими кутками (підсвічується жовтим). 



Області можуть бути кастомізовані відповідно до конкретних завдань, що 
звуться робпростори – Workspaces, які далі можуть бути перейменовані та 
збережені для пізнішого використання. 

Зміна розміру – Resizing 

 
Ви можете змінювати розмір областей, перетягуючи за їх границі за 

допомогою LMB . Наведіть курсор вашої миші над границею між двома 

областями, допоки він не зміниться на двосторонню стрілку, а потім клацніть та 
тягніть. 

Розділювання – Splitting 

 
Розділення області створить нову область. Розміщення вказівника миші на 

кутку області змінить вказівник на хрест (+) для вказування, що 

натискання LMB  активує оператор розділення або сполучення. Перетягування 

від кутка області всередину буде розділяти область. Ви визначаєте напрям 
розділення шляхом перетягування горизонтально або вертикально. 

Сполучення – Joining 

 
Редактор Властивостей сполучається зі Структуратором. 
Перетягування від кутка області назовні буде сполучати дві області. 

Область, яка буде закрита, підсвічується темнішим відтінком з вказуванням на 
неї стрілкою. Ви можете вибрати, як область буде закрита, шляхом 

переміщування миші над областями. Відпустіть LMB  для завершення 

сполучення. Якщо ви натиснете Esc  або RMB  перед відпусканням миші, то 

операція буде перервана. 
Примітка 



Області, що будуть сполучені, повинні мати однаковий розмір (ширину або 
висоту) у напрямку, в якому ви бажаєте сполучити, інакше нічого не 
відбуватиметься. Це так, щоб комбінована залишалася прямокутником. 

Опції Області – Area Options 

RMB  клацання на границі відкриває спливне меню «Опції Області» – Area 

Options. 
Розділити Область – Split Area 
Показує лінію індикатора, що дозволяє вам вибрати область та позицію, де 

відбудеться розділення. Tab  натискання перемикає між 

вертикальним/горизонтальним напрямами. 
Сполучити Область – Join Area 
Показує напрям перекриття для сполучення. 
Обмін Вмістом – Swapping Contents 

Ви можете обміняти між собою вміст двох областей за допомогою Ctrl-

LMB  на одному з кутків первинної області, тягнути у напрямку цільової області 

та відпустити мишу там. Ці дві області не потребують бути пліч-о-пліч поряд, 
хоча вони повинні бути всередині одного і того ж вікна. 

Дублювати Область у Нове Вікно – Duplicate Area into New Window 
Орієнтир – Reference 
Меню – Menu 

«Огляд > Область > Дублювати Область у Нове Вікно» – View ‣ Area ‣  

Duplicate Area into new Window  

Нове плавуче вікно, що містить область, може бути створено за допомогою 

«Огляд > Область > Дублювати Область у Нове Вікно» – View ‣ Area ‣ Duplicate  

Area into new Window . 

Це нове вікно є повністю функціональним вікном, яке є частиною цього ж 
примірника Blender’а. Воно може бути корисним, наприклад, якщо ви маєте 
кілька моніторів. 

Ви можете також створити нове вікно з наявної області шляхом Shift-

LMB  на кутку області, потім потягнувши назовні трохи. 

Таке вікно може бути закритим стандартною кнопкою «Закрити Вікно» 
для вашої операційної системи. 

Перемкнути Максимізацію Області – Toggle Maximize Area 
Орієнтир – Reference 
Меню – Menu 

«Огляд > Область > Перемкнути Максимізацію Області» – View ‣ Area ‣  

Toggle Maximize Area  

Скорочення – Hotkey 

Ctrl-Spacebar  

Максимізована область заповнить усе вікно застосунку. Ви можете 
максимізувати область за допомогою пункту меню «Огляд > Область > 



Перемкнути Максимізацію Області» – View ‣ Area ‣ Toggle Maximize Area  або 

скорочення Ctrl-Spacebar . Для повернення до нормального розміру 

використовуйте клавіатурне скорочення або кнопку «Назад у Попереднє» – Back 
to Previous на верхній смузі Topbar. 

Примітка 
Область, над якою ваша миша поточно висить, буде максимізуватися при 

використанні цих клавіатурних скорочень. 
Перемкнути Область на Повний Екран – Toggle Fullscreen Area 
Орієнтир – Reference 
Меню – Menu 

«Огляд > Область > Перемкнути область на Повний Екран» – View ‣ Area  

‣ Toggle Fullscreen Area  

Скорочення – Hotkey 

Ctrl-Alt-Spacebar  

Повноекранна область містить тільки головний регіон. Для виходу з 
повного екрана перемістіть мишу у верхній правий куток області, щоб з’явилася 
іконка повернення. 
Вкладки й Панелі – Tabs & Panels 

Вкладки – Tabs 

 
Зверху: Горизонтальний заголовок Вкладок у Верхній смузі. Внизу: 

Вертикальний заголовок Вкладок показує іконки вкладок у Редакторі 
Властивостей. 

Вкладки використовуються для керування перекривними секціями в 
інтерфейсі користувача. Вміст лише однієї Вкладки видимий одночасно. 
Вкладки перелічуються у заголовку Вкладок, який може бути вертикальним або 
горизонтальним. 

Перемикання/Обходження – Switching/Cycling 

Вертикальні вкладки можуть перемикатися за допомогою Ctrl-

Wheel  будь-де у регіоні, а горизонтальні вкладки за допомогою вказівника миші 

над заголовками вкладок. 

Ви можете також обходити по вкладках за допомогою Ctrl-Tab  та Shift-

Ctrl-Tab , або натиснути LMB  та рухати мишею по іконках заголовка вкладок. 

Панелі – Panels 



 
Панелі у Редакторі Властивостей. 
Панель підсвічується жовтим, а під-панель – червоним. 
Найменша організаційна одиниця в інтерфейсі користувача – це панель – 

panel. Заголовок панелі є завжди видимим, і він показує титр для панелі. Панелі 
можуть також включати під-панелі. 

Згортання і Розгортання – Collapsing and Expanding 
Панель може розгортатися для показу її вмісту або згортатися для схову їх 

вмісту. Розгорнута панель позначається стрілкою вниз (▼) у заголовку панелі, 
тоді як згорнута панель показується зі стрілкою управо (►). 

 Клацання LMB  на заголовку панелі розгортає або згортає її. 

 Натискання A  розгортає/згортає панель під вказівником миші. 

 Клацання Ctrl-LMB  на заголовку певної панелі згортає усі інші 

панелі й залишає розгорнутою лише цю. 

 Протягування з утримуваною натисненою LMB  по заголовках 

даватиме розгортання або згортання кількох панелей за раз. 
Позиція – Position 
Ви можете змінювати позицію панелі у межах її регіону шляхом клацання 

та перетягування її за допомогою LMB  за віджет хапання (::::), розміщений у 

Заголовку Панелі на правій стороні. 
Пришпилювання – Pinning 
Інколи бажано переглядати панелі з різних вкладок одночасно. Це може 

бути вирішено за допомогою пришпилювання панелей. 
Пришпилена панель залишається видимою, незалежно від того, яка з 

вкладок вибрана. Ви можете пришпилити панель шляхом клацання на іконці 
пришпилення в її заголовку. Панелі, що не мають іконки пришпилення, можуть 



також пришпилюватися шляхом RMB  та вибирання Pin, альтернативно ви 

можете використати Shift-LMB  на панелі також для її пришпилення. 

Зумування – Zoom 
Фактор зумування (присунення-відсунення) цілого регіону може бути 

змінено клацанням і утримуванням натисненими Ctrl-MMB  та рухом миші у 

межах цього регіону або використання NumpadPlus  та NumpadMinus  для 

присування та відсування його вмісту. Натискання Home  (Показати Усе – Show 

All) буде скидати зумування екрана/панелі, фокусованих під курсором миші. 
Режими – Modes 
Залежно від типу об’єкта, що ви намагаєтеся моделювати, існують різні 

типи режимів – modes моделювання. Оскільки режими не є специфічними для 
моделювання, вони розглядаються у різних частинах цього підручника. 

Перемикання між режимами під час моделювання є загальним. Деякі 
засоби можуть бути доступні у більше ніж одному режимі, тоді як інші можуть 
бути унікальними для певного режиму. 

Режим Редагування – Edit Mode 
Режим редагування є головним режимом, в якому відбувається 

моделювання. Режим редагування використовується для редагування наступних 
типів об’єктів: 

 Сіті – Meshes 
 Криві – Curves 
 Поверхні – Surfaces 
 Метакулі – Metaballs 
 Об’єкти тексту – Text objects 
 Решітка – Lattice 
Ви можете модифікувати лише сіть об’єктів, які ви редагуєте. Для 

модифікування інших об’єктів ви можете полишити Режим Редагування – Edit 
Mode, вибрати інший об’єкт та увійти у Режим Редагування або скористатися 
редагуванням кількох одночасно об’єктів – Редагування Кількох одночасно 
Об’єктів – Multi-Object Editing. 

5. Режими Моделювання – Modeling Modes. 
3D Огляд – 3D View має три основні режими, що дозволяють створення, 

редагування та маніпуляцію моделями сітей. Кожен з цих трьох режимів має 
розмаїття засобів. Деякі засоби можуть бути знайдені в одному або кількох 
режимах. 

Режими, що використовуються для моделювання: 
Режим Об’єкта – Object Mode 

Підтримує базові операції, такі як створення об’єктів, сполучення об’єктів, 
управління ключами форм, шари UV/кольору. 
Режим Редагування – Edit Mode 

Використовується для більшості операцій редагування сітей. 
Режим Ліплення – Sculpt Mode 

Замість того, щоб займатися індивідуальними елементами сітей, 
підтримується ліплення за допомогою пензлів. 
5.1. Смуга засобів – Toolbar: 



Засоби режиму редагування Edit Mode для сітей: 
Вибір – Select 
Вибір або переміщення. 
Вибір Коробкою – Select Box 
Вибирається геометрія шляхом натягування коробки. 
Вибір Кругом – Select Circle 
Вибирається геометрія шляхом натягування круга. 
Вибір Ласо – Select Lasso 
Вибирається геометрія шляхом натягування ласо. 
Видавити Регіон – Extrude Region 
Видавлюється вибраний регіон разом вільно або уздовж осі. 
Видавити Уздовж Нормалей – Extrude Along Normals 
Видавлюється Регіон уздовж їх локальних нормалей. 
Видавити Індивідуально – Extrude Individual 
Видавлюється кожен індивідуальний елемент уздовж їх локальних 

нормалей. 
Видавити до Курсора – Extrude To Cursor 
Видавлюються вибрані вершини, ребра або грані у напрямку курсора миші. 
Вкласти Грані – Inset Faces 
У вибрані грані здійснюється вкладка. 
Скіс – Bevel 
Створюється скіс з вибраних елементів. 
Наріз Петлі – Loop Cut 
Створюється наріз петлі уздовж сіті. 
Наріз і Ковзання Петлі – Loop Cut and Slide 
Створюється наріз петлі уздовж сіті й ковзається уздовж ребер. 
Ніж – Knife 
Створюється наріз ножем у сіті. Натискайте Enter для підтвердження 

нарізу. 
Половинення – Bisect 
Здійснюється половинення сіті. 
Poly Build 
Створюється геометрія шляхом додання вершин одна за одною. 
Обкрут – Spin 
Створюється нова геометрія шляхом видавлювання та обертання. 
Обкрут Дублікатів – Spin Duplicate 
Створюється нова геометрія шляхом дублювання та обертання. 
Згладження – Smooth 
Сплощуються кути вибраних вершин. 
Рандомізація – Randomize 
Рандомізація вибраних вершин. 
Ковзання Ребра – Edge Slide 
Ковзається ребро уздовж граней. 
Ковзання Вершини – Vertex Slide 
Ковзається вершина уздовж ребра. 
Стискання/Розтискання – Shrink/Flatten 
Стискаються вибрані вершини уздовж їх нормалей. 



Уштовх/Виштовх – Push/Pull 
Уштовхуються або виштовхуються (масштабуються) вибрані елементи. 
Косування – Shear 
Косуються вибрані елементи. 
До Сфери – To Sphere 
Переміщуються вершини назовні у сферичній формі навколо центра 

об’єкта. 
Розірвати Регіон – Rip Region 
Розриваються Полігони та переміщується результат. 
Розірвати Ребро – Rip Edge 
Розширюються вершини та переміщується результат. 

 
5.2. Сіті – Meshes. 

Структура – Structure. 
Із сітями все будується з трьох базових структур: вершини, ребра та грані. 

 
Приклад структури сіті. 
Вершини – Vertices 
Найбільш елементарною частиною сіті є вершина (вершини у множині), 

яка є одиничною точкою або позицією у 3D просторі. Вершини представляються 
у 3D Оглядвікні у режимі редагування Edit Mode як маленькі точки. Вершини 
об’єкта зберігаються як масив координат. 

Ребра – Edges 
Ребро завжди з’єднує дві вершини прямою лінією. Ребра – це «дроти», які 

ви бачите, коли дивитися на сіть у каркасному огляді. Вони зазвичай невидимі 
на рендереному зображенні. Вони використовуються для конструювання граней. 

Грані – Faces 
Грані використовуються для побудови фактичної поверхні об’єкта. Вони - 

це те, що ви бачите, коли рендерите сіть. Якщо ця область не містить граней, то 
вона буде просто прозорою або не існувати на рендереному зображенні. 

Грань визначається як область між трьома (трикутники), чотирма 
(чотирикутники) або більше (N-бічники) вершинами з ребром на кожній стороні. 
Грані часто скорочено називаються трибічники, чотирибічники та N-бічники 
– tris, quads & n-gons. 



Трикутники є завжди плоскі і тому легші для розрахування. З іншого боку, 
чотирикутники «добре деформуються» і тому бажані для анімації підподіленого 
моделювання. 

Нормалі – Normals 
У геометрії нормаль – це напрямок або лінія, що є перпендикулярною до 

чогось, типово, трикутника або поверхні, але може також бути відносно лінії, 
дотичної лінії для точки на кривій або дотичної площини для точки на поверхні. 

 
Візуалізація нормалей граней тора. 
На ілюстрації вище кожна синя лінія представляє нормаль для граней тора. 

Такі лінії кожна є перпендикуляром до грані, якій вона належить. Ця візуалізація 
може бути активована у Режимі Редагування у панелі «Показ Сіті» Накладок 
Оглядвікна – Mesh Display Viewport Overlays panel. 

Властивості – Properties 
Орієнтир – Reference 
Панель – Panel 

«Редактора Властивостей > Дані Об’єкта > Нормалі» – Properties editor ‣  

Object Data ‣ Normals  

 
Панель «Нормалі» – Normals. 
Авто Згладження – Auto Smooth 
Ребра, де кут між гранями є меншим, ніж вказаний у кнопці «Кут» – Angle, 

буде згладжено, при відтінюванні ці частини сіті задаються показуватися 
згладжено. Це легший спосіб комбінувати згладжені та гострі ребра. 

Кут – Angle 
Поле числа кута. 



 
Приклад сіті з увімкненим Auto Smooth. 
Просунуте Згладжене Відтінювання та Гострі Ребра – Advanced Smooth 

Shading & Sharp Edges 
By default in Blender, with basic normal computing behavior, a sharp edge is 

always defined as an edge being either non-manifold, or having at least one of its faces 
defined as flat. 

Enabling the Auto Smooth setting adds an extra parameter to define a sharp edge, 
the Angle threshold between two neighbor faces, above which the edge will always be 
considered as sharp. 

Auto Smooth завжди вмикає оброблення кастомних розділених 
нормалей Custom Split Normals, які можуть бути, або визначені (та редаговані) як 
шар даних сіті – mesh data layer, або генеруватися на льоту модифікаторами. У 
будь-якому випадку, коли сіть отримує кастомні нормалі, то вони завжди 
замінюють стандартні, що обчислюються Auto Smooth. 

Sharp edges may still be used by the custom normals modifiers to compute their 
normals, depending on their settings. 

Кастомні Розділені Нормалі – Custom Split Normals 
Custom Split Normals – це спосіб підправлення/підроблення відтінювання 

шляхом направляння нормалей в інших напрямках, ніж стандартний, їх авто 
обчислюючи. Він здебільшого використовується у розробці ігор, де це допомагає 
урівноважити деякі проблеми, генеровані низько-полігональними об’єктами 
(найбільш поширеними прикладами є низько-полігональні дерева, кущі, трава 
тощо та «закруглені» кутки). 

Blender підтримує кастомні нормалі на основі «згладжене віяло», що 
визначається як набір сусідніх кутків граней, що спільно використовують одну і 



ту ж вершину та «пов’язані» ребрами згладження. Це означає, що ви можете мати 
нормалі для кожного кутка грані, на набір сусідніх кутків граней або для кожної 
вершини. 

Вмикання Кастомних Розділених Нормалей – Enabling Custom Split 
Normals 

Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Сіть > Нормалі > Розділення» – Mesh ‣ Normals ‣ Split  

Enables custom split normals. 
Також, будь-який із засобів редагування кастомних нормалей (дивіться 

нижче) буде, як зручність, вмикати кастомні нормалі, якщо вони ще не увімкнені. 
Редагування Кастомних Розділених Нормальней – Editing Custom Split 

Normals 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Сіть > Нормалі» – Mesh ‣ Normals  

Скорочення – Hotkey 

Alt-N  

Існує ряд засобів для редагування кастомних розділених нормалей. Засоби 
редагування кастомних нормалей сіті можуть впливати на всі нормалі (стандарт) 
або лише на вибрані. Для вибору кастомних нормалей, асоційованих з певною 
вершиною та гранню: 

 Зробіть режим вибрання елементів одночасно Вершин і Граней 

(використайте Shift-LMB  для вмикання ще й другого). 

 Виберіть одну чи кілька вершин, потім виберіть грань. Це може бути 
повторено для вибору більше вершин та іншої грані і так далі. Найлегше бачити 
ефект цих засобів, якщо ви увімкнете опцію Накладок Режиму Редагування 
«Показ нормалей вершин-на-грань як ліній» – Display vertex-per-face normals as 
lines. 

Імпортування Кастомних Розділених Нормалей – Importing Custom 
Split Normals 

Деякі засоби, особливо ті, що використовуються у САПР (системах 
автоматизованого проектування) – CAD, тяжіють генерувати нерегулярну 
геометрію при теселюванні їх об’єктів у сіті (дуже тонкі та довгі трикутники 
тощо). Авто-обчислені нормалі на такій геометрії часто дають погані артефакти, 
тому важливо бути у змозі імпортувати та використовувати нормалі, генеровані 
сами засобами САПР. 

Топологія – Topology 
Петлі – Loops 



 
Петлі ребер та граней. 
Петлі ребер та граней є наборами граней або ребер, що формують 

безперервні «петлі», як показано на Ілюстрації Петлі ребер та граней.. 
На зображенні вище петлі, що не закінчуються у полюсах, є зацикленими 

(1 та 3). Вони починаються та закінчуються у тій самій вершині та ділять модель 
на дві частини. Петлі можуть бути швидким та потужним засобом роботи зі 
специфічними, продовжуваними регіонами сіті та є передумовою для органічної 
анімації персонажів. Щодо детального опису, як працювати з петлями у 
Blender’і, дивіться: Edge Loop Selection. 

 
Петлі Ребер – Edge Loops 
Петлі (1 та 2) на Ілюстрації Петлі ребер та граней. є петлями ребер. Вони 

з’єднують вершини так, що кожна з них на петлі має точно два сусіди, що не є на 
цій петлі, та поміщаються на обох сторонах петлі (за винятком початкової та 
кінцевої вершини у випадку полюсів). 

Петлі ребер є важливою концепцією, особливо, в органічному 
(підподіленому) моделюванні та анімації персонажів. При коректному 
використанні вони дозволяють вам будувати моделі з відносно небагатьма 
вершинами, що виглядать дуже природно при використанні як підподілених 
поверхонь та деформуються дуже добре в анімації. 

Візьміть Ілюстрацію Петлі ребер та граней. як приклад органічного 
моделювання: петлі ребер слідують за природними контурами й лініями 
деформацій шкіри та м’язів, що лежать під нею, і є густішими в областях, які 
більше деформуються, коли персонаж рухається, наприклад, на плечах або 
колінах. 

Петлі Граней – Face Loops 
Вони є логічним продовженням петель ребер у тому, що вони складаються 

з граней між двома петлями ребер, як показано у петлях (3 та 4) на 
Ілюстрації Петлі ребер та граней.. Зауважте, для не-зациклених петель (4) грані, 
що містять полюси, не включаються у петлю граней. 

 
Примітиви – Primitives 
Орієнтир – Reference 
Режим – Mode 
Режим Об’єкта та Режим Редагування – Object Mode and Edit Mode 
Меню – Menu 



«Додання > Сіть» – Add ‣ Mesh  

Скорочення – Hotkey 

Shift-A  

Поширений тип об’єкта, що використовується у 3D сцені, – це сіть. Blender 
поставляється з низкою «примітивних» форм сітей, з яких ви можете почати 
моделювання. Ви можете також додавати примітиви у Режимі Редагування – Edit 
Mode у місці 3D курсора. 

 
Стандартні примітиви Blender’а. 
Загальні Опції – Common Options 
Ці опції можуть вказуватися у панелі Наладнати Останню Операцію – 

Adjust Last Operation, яка з’являється, коли створюється об’єкт. Опції, включені 
для більш ніж одного примітива: 

Генерувати UVи – Generate UVs 
Генерує стандартне розгортування UV для нової геометрії. Це буде 

визначено у першому шарі UV (який буде додано при необхідності). 
Радіус/Розмір, Вирівняти за Оглядом, Локація, Обертання – 

Radius/Size, Align to View, Location, Rotation 
 
Площина – Plane 
Стандартна площина - це одинична квадратна грань, яка складається з 

чотирьох вершин, чотирьох ребер та однієї грані. Вона як аркуш паперу, що 
лежить на столі; вона не є тривимірним об’єктом, оскільки вона плоска і не має 
товщини. Об’єкти, що можуть бути створені за допомогою площин, включають 
підлоги, стільниці або дзеркала. 

Cube – Куб 
Стандартний куб містить вісім вершин, дванадцять ребер та шість граней і 

є тривимірним об’єктом. Об’єкти, що можуть бути створені з кубів, включають 
гральні кості, коробки або ящики. 

Коло – Circle 



Вершини – Vertices 
Кількість вершин, що визначають коло або полігон. 
Тип заповнення – Fill Type 
Вказує, як коло буде заповнено. 
Віяло Трикутників – Triangle Fan 
Заповнюється трикутними гранями, що спільно використовують вершину 

в середині. 
N-бічник – N-gon 
Заповнюється єдиним N-бічником – n-gon. 
Ніщо – Nothing 
Не заповнюється. Створює лише зовнішнє кільце вершин. 
Сфера UV – UV Sphere 
Стандартна сфера UV утворюється з квадратних граней та віял трикутників 

на верху і на низу. Вона може використовуватися для текстурування. 
Сегменти – Segments 
Кількість вертикальних сегментів. Які меридіани Землі, що йдуть від 

полюса до полюса. 
Кільця – Rings 
Кількість горизонтальних сегментів. Це як паралелі Землі. 
Примітка 
Кільця – це петлі граней (face loops), а не петлі ребер (edge loops), яких було 

б на один менше. 
Ікосфера – Icosphere 
Ікосфера – це багатогранна сфера, що утворюється з трикутників. 

Ікосфери, зазвичай, використовуються для більш ізотропного розстави вершин, 
ніж з сферою UV, іншими словами, вони розташовуються рівномірно у кожному 
напрямку. 

Підподілення – Subdivisions 
Скільки рекурсій використовуються для визначення сфери. На рівні 1 

ікосфера є ікосаедром, тіло з 20 рівносторонніми трикутними гранями. Кожне 
збільшення у кількості підподілень розділяє кожну трикутну грань на чотири 
трикутники. 

Примітка 
Підподілювання ікосфери дуже швидко збільшує рахунок вершин навіть з 

кількома повторами (10 разів створює 5’242’880 трикутників), Додання такої 
щільної сіті є вірним способом спричинити крах програми. 

Циліндр – Cylinder 
Об’єкти, які можна створити з циліндра, включають ручки та стрижні. 
Вершини – Vertices 
Число вертикальних ребер між колами використовується для визначення 

циліндра або призми. 
Глибина – Depth 
Встановлює початкову висоту циліндра. 
Тип Заповнення Торця – Cap Fill Type 
Подібно до кола (дивіться вище). Коли не задано жоден, то створений 

об’єкт буде трубою. Об’єкти, що можуть створюватися з труб, включають 
трубопроводи або питні стакани (базова відмінність між циліндром та трубою 



полягає у тому, що перший має закриті кінці). 
Конус – Cone 
Об’єкти, які можна створити з конусів, включають шипи та загострені 

капелюхи. 
Вершини – Vertices 
Кількість вертикальних ребер між колами або верхівкою, що 

використовуються для визначення конуса або піраміди. 
Радіус 1 – Radius 1 
Встановлює радіус кругової основи конуса. 
Радіус 2 – Radius 2 
Sets the radius of the tip of the cone. Which will create a frustum (a pyramid or 

cone with the top cut off). A value of 0 will produce a standard cone shape. 
Глибина – Depth 
Встановлює початкову висоту конуса. 
Тип Заповнення Бази – Base Fill Type 
Подібно до кола (дивіться вище). 
Тор – Torus 
Примітив у формі пончика, створений обертанням кола навколо осі. 

Загальні розмірності можуть визначатися двома методами. 
Передустави Оператора – Operator Presets 
Устави передустави тора для повторно використання. Ці передустави 

зберігаються як скрипти у відповідному каталогу передустав. 
Мажорні Сегменти – Major Segments 
Кількість сегментів для головного кільця тора. Якщо ви думаєте про тор як 

операцію «обкручення» навколо осі, то це скільки кроків є в обкрученні. 
Мінорні сегменти – Minor segments 
Кількість сегментів для малого кільця тора. Це кількість вершин кожного 

кругового сегмента. 
Розмірності Тора – Torus Dimensions 
Режим Додання – Add Mode 
Змінюється спосіб визначення тора. 
Мажорне/Мінорне, Зовнішнє/Внутрішнє – Major/Minor, Exterior/Interior 
Мажорний Радіус – Major Radius 
Радіус від початку (origin) до центру поперечного перетину. 
Мінорний Радіус – Minor Radius 
Радіус поперечного перерізу торів. 
Зовнішній Радіус – Exterior Radius 
Якщо дивитися уздовж мажорної осі, то це радіус від центра до 

зовнішнього краю. 
Внутрішній Радіус – Interior Radius 
Якщо дивитися уздовж мажорної осі, то це радіус отвору в центрі. 
Сітка – Grid 
Регулярна квадратична сітка, яка є підподіленою площиною. Приклади 

об’єктів, що можуть бути створені зі сіток, включають ландшафти та органічні 
поверхні. 

Підподілення X – X Subdivisions 
Кількість проміжків по осі X. 



Підподілення Y – Y Subdivisions 
Кількість проміжків по осі Y. 
Мавпа – Monkey 
Це додає стилізовану голову мавпи для використання як тестової сіті, 

використовуйте Subdivision Surface для уточненої форми. 
Вона призначена як тестова сіть, подібно до: 
 Чайник Юти – Utah Teapot 
 Стенфордський Кролик – Stanford Bunny. 
5.3. Вибирання – Selecting. 
Існує багато способів вибирати елементи, і залежить від того, в якому 

режимі вибору сіті – Mesh Select Mode ви знаходитеся, які засоби вибрання 
доступні. Спершу ми пройдемося по цих режимах та після розглянемо базові 
засоби вибрання. 
5.3.1. Режими Вибрання – Selection Modes 

Кнопки Заголовка для Режимів Вибору – Select Mode Header Buttons 
Орієнтир – Reference 
Режим 
Режим Редагування – Edit Mode 
Меню – Menu 

«Заголовок 3D Огляду > Режим Вибору» – 3D View Header ‣ Select Mode  

Скорочення – Hotkey 

1 , 2 , 3  ( Shift  Кілька режимів вибору , Ctrl  Розгорнути/Згорнути вибір ) 

 
Кнопки вибору Режиму Редагування. 

У Режимі Редагування – Edit Mode існують три різних режими вибрання. 
Ви можете входити у ці різні режими, вибираючи одну з трьох кнопок у 
заголовку. 

Вершини – Vertices. У цьому режимі вершини показуються як точки. 
Вибрані вершини показуються оранжевим, невибрані вершини – чорним, а 

активна або останньо вибрана вершина – білим. 
Краї. У цьому режимі вершини не показуються. 
Натомість, вибрані ребра показуються оранжевим, невибрані ребра – 

чорним, а активне чи останньо вибране ребро – білим. 
Грані – Faces. У цьому режимі грані показуються з точкою вибрання у 

середині, яка використовується для вибирання грані. 
Вибрані грані та їх точки вибрання показуються оранжевим, невибрані 

грані показуються чорним, а активна або останньо вибрана грань підсвічується 
білим. 

Використовуючи ці кнопки, ви можете користуватися модифікаційними 
клавішами. 



Майже усі засоби доступні у всіх трьох режимах вибрання сіті. Тому ви 
може обертати – Rotate, масштабувати – Scale, видавлювати – Extrude тощо в 
усіх режимах. Звичайно, обертання та масштабування одиничної вершини не 
буде робити нічого корисного (без установлення опорної точки в іншій локації), 
тому деякі засоби є більш або менш застосовні у деяких режимах. 
5.3.2. Кількома одночасно Режимів Вибрання – Multiple Selection Modes 

Утримуючи Shift-LMB  при вибиранні режиму вибрання, ви можете 

вмикати кілька одночасно Selection Modes за раз. Це дозволяє вам швидко 
вибирати Вершини/Ребра/Грані без потреби спершу перемикати режими. 

Режими вибрання. 

 
Приклад режиму вибору Вершин – 
Vertex. 

 
Приклад режиму вибору Ребер – 
Edge. 

 
Приклад режиму вибору Граней – 
Face. 

 
Приклад змішаного режиму. 

5.3.3. Перемикання Режиму Вибору – Switching Select Mode 
При перемиканні режимів у висхідному порядку (тобто, від простішого до 

більш складного), від Vertices до Edges та від Edges до Faces, вибрані частини 
залишаться вибраними, якщо вони утворюють повний елемент у новому режимі. 

Наприклад, якщо всі чотири ребра у грані вибрано, то перемикання з 
режиму Edges на режим Faces збереже цю грань вибраною. Усі вибрані частини, 
що не формують завершений набір у новому режимі, будуть зневибрані. 



 
Режим вибору Ребер, початкове 
вибрання. 

 
Перемикання у режим вибору 
Граней. 

Звідси, перемикання у спадному порядку (тобто, від більш складного до 
простішого), всі елементи, що визначають елемент «вищого рівня» (такий як 
грань) будуть вибраними (наприклад, чотири вершини або ребра у 
чотирикутнику). 
5.3.4. Розширення/Звуження Вибрання – Expand/Contract Selection 

Утримуючи Ctrl  при вибиранні вищого режиму вибрання, всі елементи, 

що торкаються поточного вибрання, будуть додані, навіть якщо вибрання не 
формує цілий елемент вищого рівня. 

Або звужування вибрання при переході до нижчого режиму. 

 
Режим вибору Вершин, початкове 
вибрання. 

 
Розширювання у режим вибору 
Ребер. 

5.3.5. Просвічення – X-Ray 
Устава x-ray є не лише для відтінення, вона впливає також на вибрання. 
При увімкненні вибрання не буде загороджуватися геометрією об’єктів (як 

би об’єкт був суцільним). 

 
Увімкнено X-ray.  



Вимкнено X-ray.  

5.4. Меню «Вибір» – Select Menu 

Все – Все A  

Вибирається усе. 

Жоден Alt-A  

Знімається вибір. 

Інверсія – Inverse Ctrl-I  

Вибирає всю геометрію, що не є вибраною, та знімає вибір з поточних 
вибраних компонентів. 

Вибір Коробкою – Box Select B  

Інтерактивне вибрання коробкою. 

Вибір Кругом – Circle Select C  

Інтерактивне вибрання кругом. 
Вибрати Випадково – Select Random 
Вибирає випадкову групу вершин, ребер або граней, виходячи з 

відсоткового значення. 
Зневибрати Шахово – Checker Deselect 
Зневибираються поперемінно елементи відносно активного елемента. 
Вибрати Гострі Ребра – Select Sharp Edges 
Цей засіб вибирає всі ребра між двома гранями, що формують кут, більший 

ніж значення цього кута, де при збільшенні кута вибирає гостріші ребра. 

Вибрати Подібне – Select Similar Shift-G  

Вибираються елементи, подібні до поточного вибрання. 
Вибрати все за ознакою 
Вибирається геометрія шляхом запитування її характеристик. 
Вибрати Більше/Менше – Select More/Less 

Більше – More Ctrl-NumpadPlus  

Розширює вибрання до суміжних елементів цього типу вибрання. 

Менше – Less Ctrl-NumpadMinus  

Звужує вибрання від суміжних елементів цього типу вибрання. 

Наступне Активне – Next Active Shift-Ctrl-NumpadPlus  

Це використовує історію вибрання для вибирання наступних 
вершини/ребра/грані на основі навколишньої топології. 

Попереднє Активне – Previous Active Shift-Ctrl-NumpadMinus  

Вибір попереднього просто знімає вибрання з останнього вибраного 
елемента. 

Вибрати Петлі – Select Loops 
Петлі країв 
Вибираються з’єднані ребра. 
Петлі для обличчя 
Вибираються з’єднані грані. 
Крайове кільце 



Вибирається кільце з’єднаних ребер. 
Вибрати Пов’язане – Select Linked 
Виберіть "Пов'язано" 
Вибирає усі компоненти, що є з’єднаними у поточному вибранні 

(дивіться Select Linked). 
Найкоротший шлях 
Шлях між двома вибраними елементами. 
Пов’язані Плоскі Грані – Linked Flat Faces 
Вибираються з’єднані грані на основі порогу кута між ними. Це корисно 

для вибирання граней, що є планарними. 
Вибрати Бік Активного – Select Side of Active 
Вибираються всі вершини на сіті в одиничній осі відносно активної 

вершини. Лише у режимі вибрання Vertex. 

Дзеркалити Вибрання – Mirror Selection Shift-Ctrl-M  

Вибираються елементи сіті у дзеркальному розташуванні через обрану 
вісь. 

5.5. Засоби Вибирання – Selection Tools 
5.5.1. Зневибрати Шахово – Checker Deselect 

Орієнтир – Reference 
Режим 
Режим Редагування – Edit Mode 
Меню – Menu 

«Вибір > Зневибрати Шахово» – Select ‣ Checker Deselect  

Це засіб застосовує перемінний шаховий патерн для 
вибирання/зневибирання. Це працює лише якщо ви вже маєте більше ніж один 
елемент сіті вибраним. 

Змінює поточне вибрання так, що лише кожен Nй з елементів (вершини, 
ребра або грані, залежно від активного режиму вибрання) залишатиметься 
вибраним, починаючи з активного. 

У випадку островів вибраних елементів цей засіб буде впливати лише на 
острів активного елемента (якщо такий є) або на острів першого елемента у 
порядку внутрішнього зберігання (якщо там немає жодного активного елемента). 

Знято – Вибір знято 
Кількість зневибраних елементів у кожному повторенні патерну. 
Вибране – Selected 
Кількість вибраних елементів у кожному повторенні патерну. 
Зсув – Offset 
Зсув від точки старту. 

5.5.2. Вибрати Усе за Рисою – Select All by Trait 
Не Розгортне – Non Manifold 
Вибирає не-розгортну – non-manifold геометрію сіті. Цей запис доступний 

при редагуванні сіті лише у режимах вибрання Vertex та Edge. 
Розширяння – Extend 
Дозволяє розширити поточне вибрання. 
Дріт – Wire 
Вибирає всі ребра, що не належать жодній грані. 



Рубежі – Boundaries 
Вибирає ребра на рубежах та отворах. 
Кілька Граней – Multiple Faces 
Вибирає ребра, що належать трьом або більше граням. 
Чи не Стичне – Non Contiguous 
Вибирає ребра, що належать точно двом граням з протилежними 

нормалями. 
Вершини – Vertices 
Вибирає вершини, що належать до ребер дроту та кількох граней, 

ізольовані вершини та вершини, що належать не-прилеглим граням. 
Незв’язана Геометрія – Loose Geometry 
Це вибрання залежить від поточно обраного режиму вибрання Selection 

Modes; У режимах вибрання вершин та ребер це вибирає усі вершини або ребра, 
що не формують частину грані. У режимі вибрання граней це вибирає усі грані, 
що спільно не використовують ребра з іншими гранями. 

Внутрішні Грані – Interior Faces 
Вибирає грані, в яких усі ребра мають більше ніж дві грані. 
Грані за Боками – Faces by Sides 
Вибирає усі грані, що мають вказану кількість ребер. 
Негруповані Вершини – Ungrouped Vertices 
Вибирає усі вершини, що не є частиною групи вершин – vertex group. 

5.5.3. Вибрати Пов’язане – Select Linked 
Орієнтир – Reference 
Режим 
Режим Редагування – Edit Mode 
Меню – Menu 

«Вибір > Пов’язане» – Select ‣ Linked  

Скорочення – Hotkey 

Ctrl-L  

Вибирається геометрія, з’єднана зі вже вибраними елементами. Це часто 
корисно, коли сіть має роз’єднані, перекривні частини, де ізолювання її будь-
якими іншим способом було б втомливим. 

Для більшого контролю ви можете також увімкнути розмежувачі у 
панелі Наладнати Останню Операцію – Adjust Last Operation, щоб вибрання 
обмежувалося швами, гострими ребрами, матеріалами або островами UV. 

За допомогою «Підібрати Пов’язане» – Pick Linked ви можете також 

вибирати з’єднану геометрію під курсором, використовуючи скорочення L  для 

вибору або Shift-L  для зневибору пов’язаного. 

Це працює інакше у тому, що використовує геометрію під курсором 
замість від наявного вибрання. 
5.5.4. Вибрати Подібне – Select Similar 

Орієнтир – Reference 
Режим 
Режим Редагування – Edit Mode 
Меню – Menu 



«Вибір > Подібне» – Select ‣ Similar  

Скорочення – Hotkey 

Shift-G  

Вибирається геометрія, що має подібні певні властивості з вибраною, на 
основі порогу, що може бути заданий у властивостях засобу після активування 
засобу. Опції засобу змінюються залежно від режиму вибрання: 
5.5.4.1.Режим Вибрання Вершин – Vertex Selection Mode: 

Нормаль - Normal 
Вибирає всі вершини, які мають нормалі, що вказують в аналогічних 

напрямках до поточно вибраних. 
Кількість Суміжних Граней – Amount of Adjacent Faces 
Вибирає всі вершини, що мають однакову кількість граней, з’єднаних з 

ними. 
Групи Вершин – Vertex Groups 
Вибирає всі вершини в одній і тій же групі вершин – vertex group. 
Кількість З’єднувальних Ребер – Amount of Connecting Edges 
Вибирає всі вершини, що мають однакову кількість ребер, з’єднаних з 

ними. 
Регіони Граней – Face Regions 
Вибираються узгоджені риси на сіті, яка має кілька подібних областей на 

основі топології. 
5.5.4.2.Режим Вибрання Ребер – Edge Selection Mode: 

Довжина – Length 
Вибирає всі ребра, що мають подібну довжину до тих, що вже вибрані. 
Напрям – Direction 
Вибирає всі ребра, що мають подібний напрямок (кут) до тих, що вже 

вибрані. 
Кількість Граней Навколо Ребра – Amount of Faces Around an Edge 
Вибирає всі ребра, що належать однаковій кількості граней. 
Кути Граней – Face Angles 
Вибирає всі ребра між двома гранями, що утворюють подібний кут, як у 

тих, що вже вибрані. 
Складка – Crease 
Вибирає всі ребра, що мають подібне значення складки – Crease, як у тих, 

що вже вибрані. 
Скіс – Bevel 
Вибирає всі ребра, що мають таку ж Вагомість Скосу – Bevel Weight, як у 

тих, що вже вибрані. 
Шов – Seam 
Вибирає усі ребра, що мають однаковий стан «Шов» – Seam, як ті, що вже 

вибрані. Seam – це устава типу «істина/хиба», використовувана при 
текстуруванні по UV – UV texturing. 

Гострота – Sharpness 
Вибирає всі ребра, що мають однаковий стан «Гостро» – Sharp, як ті, що 

вже вибрані. Sharp – це устава (стяг) типу «істина/хиба», використовуваний 
модифікатором «Розділ Ребром» – Edge Split Modifier. 



5.5.4.3. Режим Вибрання Граней – Face Selection Mode: 
Material – Матеріал 
Вибирає всі грані, що використовують такий же матеріал, як і ті, що вже 

вибрані. 
Зображення – Image 
Вибирає усі грані, що використовують таку ж текстуру UV, як ті, що вже 

вибрані (дивіться сторінки UV texturing). 
Область – Area 
Вибирає всі грані, що мають подібну площу до тих, що вже вибрані. 
Боки Багатобічника – Polygon Sides 
Вибирає всі грані, що мають однакову кількість ребер. 
Периметр – Perimeter 
Вибирає всі грані, що мають подібний периметр (додані значення довжин 

ребер). 
Нормаль - Normal 
Вибирає усі грані, що мають подібну нормаль, як ті, що вибрані. Це спосіб 

вибрати грані, що мають однакову орієнтацію (кут). 
Копланарний 
Вибирає всі грані, що знаходяться у (майже) одній площині до тих, що вже 

вибрані. 
5.5.5. Петлі Ребер – Edge Loops 

Орієнтир – Reference 
Режим 
Режим Редагування (режим вибору Вершин або Ребер) – Edit Mode (Vertex 

or Edge select mode) 
Меню – Menu 

«Вибір > Вибрати Петлі > Петлі Ребер» – Select ‣ Select Loops ‣ Edge Loops  

Скорочення – Hotkey 

Alt-LMB  або Shift-Alt-LMB  для модифікування наявного вибрання. 

Утримування Alt  при вибиранні ребра вибирає петлю ребер, що є з’єднані 

у лінію кінець до кінця, що проходить через ребро під вказівником миші. 

Утримування Shift-Alt  при клацанні додає у поточне вибрання. 

Петлі ребер можуть бути також вибрані на основі наявного режиму 

вибрання, використовуючи «Вибір > Петлі Ребер» – Select ‣ Edge Loop . 

Примітка 
Режим вибору вершин Vertex 
У режимі вибору вершин Vertex ви також можете вибирати петлі ребер, 

використовуючи ті ж скорочення та клацаючи по ребрах (а не по вершинах). 
 
Сфера зліва показує ребро, що було вибрано по довготі. Зауважте, що ця 

петля відкрита. Це тому, що алгоритм потрапляє на вершини на полюсах та 
завершується, оскільки вершини на полюсі з’єднані з більш ніж чотирма 
ребрами. Проте, сфера справа показує ребро, що було вибрано по широті та 
сформувало закриту петлю. Це тому, що алгоритм потрапляє на те ж перше 
ребро, з якого він розпочав. 



 
Петлі ребер по довготі та широті. 
5.5.6. Петлі Ребер (Усі Рубежі) – Edge Loops (All Boundaries) 
Усі ребра рубежу можуть бути вибрані шляхом здійснювання другої дії 

вибору петлі на ребрі рубежу. 
Це може бути корисно для вибирання рубежів для сітей, що включають 

трикутники або n-бічники, де інакше б вибір петлі не вибирав повністю рубіж. 

 
Друга дія вибору петлі показана справа. 
5.5.7. Петлі Граней – Face Loops 
Орієнтир – Reference 
Режим 
Режим Редагування (режими вибору Граней або Вершин) – Edit Mode (Face 

or Vertex select modes) 
Скорочення – Hotkey 

Alt-LMB  або Shift-Alt-LMB  для модифікування наявного вибрання. 

У режимі вибору граней утримування Alt  при вибиранні ребра вибирає 

петлю граней, що є з’єднані у лінію кінець до кінця уздовж їх протилежних 
ребер. 

У режимі вибору вершин те ж саме можна виконати за допомогою Ctrl-Alt , щоб 

вибрати ребро, яке неявно вибирає петлю граней. 



 
Вибрання петлі граней. 

Ця петля граней була вибрана шляхом клацання Alt-LMB  на ребрі у 

режимі вибору граней. Петля розширяється перпендикулярно від ребра, що було 
вибрано. 

 
Alt  проти Ctrl-Alt  у режимі вибору вершин. 

Петля граней може також бути вибрана у режимі вибору вершин Vertex. 

Технічно Ctrl-Alt-LMB  буде вибирати кільце ребер Edge Ring, проте, у режимі 

вибору вершин Vertex, вибирання кільця ребер Edge Ring неявно вибирає петлю 
граней Face Loop, оскільки вибирання протилежних ребер грані неявно вибирає 
грань цілком. 

5.5.8. Кільце Ребер – Edge Ring 
Орієнтир – Reference 
Режим 
Режим Редагування – Edit Mode 
Меню – Menu 

«Вибір > Вибрати Петлі > Кільця Ребер» – Select ‣ Select Loops ‣ Edge Rings  

Скорочення – Hotkey 

Ctrl-Alt-LMB  

У режимі вибору ребер Edge утримування Ctrl-Alt  при вибиранні ребра 

(або двох вершин), вибирає послідовність ребер, що не з’єднані, а знаходяться на 



протилежних один до одного сторонах, простягаючись уздовж петлі граней 
– face loop. 

Як і для петель ребер ви можете також вибирати кільця ребер на основі 

поточного вибрання, використовуючи Select ‣ Select Loops ‣ Edge Rings . 

Примітка 
Режим вибору вершин Vertex 
У режимі вибору вершин Vertex ви можете використовувати ті ж 

скорочення, клацаючи на ребрах (не на вершинах), але при цьому будуть 
напряму вибиратися відповідні петлі граней… 

 
Вибрана петля ребер та вибране кільце ребер. 
На Ілюстрації Вибрана петля ребер та вибране кільце ребер. на тому ж 

ребрі було клацнуто, але дві різних «групи ребер» були вибрані на основі різних 
засобів. Одна з них базується на ребрах у ході обчислення, а інша - базується на 
гранях. 

Примітка 
Конвертування Вибрання у Цілі Грані – Convert Selection to Whole Faces 
Якщо вибрання кільця ребер відбулося у Режимі Вибору Ребер, то 

перемикання у Режим Вибору Граней зітре це вибрання. 
Це тому, що жодна із тих граней не має всіх (чотирьох) вибраних ребер, 

тільки два з них. 

Натомість вибирання відсутніх ребер вручну або використовуючи Shift-

Alt-  двічі, легше спершу перемкнутися у Режим Вибору Вершин, який ніби 

«заллє» це вибрання. Наступне перемикання у Режим Вибору Граней далі 
належно вибере грані. 

5.5.9. Найкоротший Шлях – Shortest Path 
Орієнтир – Reference 
Режим 
Режим Редагування – Edit Mode 
Меню – Menu 

«Вибір > Вибрати Пов’язане > Найкоротший Шлях» – Select ‣ Select  

Linked ‣ Shortest Path  

Скорочення – Hotkey 



Ctrl-LMB  

 
Вибір шляху граней або вершин за допомогою Ctrl-LMB . 

Вибирає всю геометрію уздовж найкоротшого шляху від активної 
вершини/ребра/грані до вибраної. 
 
Значник Ребра (лише у режимі вибору Ребер) – Edge Tag (in Edge select mode 
only) 

Ця кнопка вибору вказує, що повинно робитися при вибиранні шляху 

вершин за допомогою Ctrl-LMB : 

Вибір – Select 
Просто вибирає усі ребра у шляху. 
Шов бирки 
Позначає усі ребра у шляху як шви для розгортання по UV. 
Значити Гостре – Tag Sharp 
Позначає усі ребра у шляху як гострі для модифікатора Edge Split. 
Значення складки – тег складка 
Позначає усі ребра у шляху як складки для модифікатора Subdivision 

Surface з вагомістю 1.0. 
Значення фаски – тег фаски 
Задає вагомість скосу 1.0 (для модифікатора Bevel) для усіх ребер у шляху. 
Значити Позначку Ребра Freestyle – Tag Freestyle Edge Mark 
Позначає усі ребра у шляху вирізнених ребер Freestyle. 
Крокування Гранями – Face Stepping 
Підтримує діагональні шляхи для вершин та граней та вибирає кільця 

ребер за допомогою ребер. 
Топологічна Відстань – Topological Distance 
Лише враховує кількість ребер шляху та не довжину ребер для розрахунку 

відстаней. 

Заповнити Регіон – Fill Region Shift-Ctrl-LMB  

Вибирає всі елементи у найкоротшому шляху від активного вибрання до 
області, по якій клацнуто. 

Опції Зневибору Шахово – Checker Deselect Options 
Дозволяє швидко вибирати поперемінно елементи у шляху. Дивіться також 



про засіб Checker Deselect. 
Знято – Вибір знято 
Кількість зневибраних елементів у повторюваній послідовності. 
Вибране – Selected 
Кількість вибраних елементів у повторюваній послідовності. 
Зсув – Offset 
Зсув від точки старту. 
5.5.10. Внутрішній Регіон від Петлі – Loop Inner-Region 
Орієнтир – Reference 
Режим 
Режим Редагування (режим вибору Ребер) – Edit Mode (Edge select mode) 
Меню – Menu 

«Вибір > Вибрати Петлі > Вибрати Внутрішній Регіон від Петлі» – Select  

‣ Select Loops ‣ Select Loop Inner-Region  

Select Loop Inner-Region вибирає усі грані, що є всередині закритої петлі 
ребер. Хоча можливим є використання цього оператора у режимах 
вибрання Vertex та Face, результати можу бути неочікувані. Зауважте, що якщо 
вибрана петля ребер не є закритою, то всі з’єднані ребра на сіті будуть вважатися 
всередині цієї петлі. 

 
Петля в Регіон. 

 
Як ви можете бачити, цей засіб добре обробляє кілька одночасно петель. 



 
Цей засіб також добре обробляє «отвори». 
5.5.11. Петля Рубежу – Boundary Loop 
Орієнтир – Reference 
Режим 
Режим Редагування (режим вибору Ребер) – Edit Mode (Edge select mode) 
Меню – Menu 

«Вибір > Вибрати Петлі > Вибрати Петлю Рубежу» – Select ‣ Select Loops  

‣ Select Boundary Loop  

Select Boundary Loop робить протилежне до Select Loop Inner-Region, на 
основі всіх поточно вибраних регіонів він вибирає лише ребра на границі 
(контурі) цих островів. Він може оперувати у будь-якому режимі вибору, але 
коли є активним режим вибору граней Face, то він буде перемикатися у режим 
вибору ребер Edge після виконання. 

Все це набагато простіше ілюструвати прикладами: 

 
Select Boundary Loop робить протилежне та примусово перемикає в 

Режим Вибору Ребер. 
5.5.12. Відомі Проблеми – Known Issues 
Щільні сітки 
Вибір щільних сіток з вимкненим рентгенівським промінням має 

обмеження, через яке для щільних сіток можуть бути вибрані не всі елементи. 
Під час вибору областей за допомогою функцій вибору «Блок», «Коло» та 

«Ласо» вершини можуть перекриватися одна з одною, через що деякі вершини 



не будуть вибрані. 
Це обмеження поточного методу вибору, ви можете обійти це, збільшивши 

масштаб або ввімкнувши рентген. 
N-Бічники у Режимі Вибору Граней – N-Gons in Face Select Mode 

 
Грань N-бічника має її центральну точку всередині іншої грані. 
Як уже зазначалося, у режимах X-Ray та Wireframe грані позначені 

крапкою посередині. У випадку n-кутників, це може призвести до плутанини у 
деяких випадках. У прикладі показано, що центральна точка U-подібного n-
кутника знаходиться всередині довгастої грані всередині літери «U». Нелегко 
сказати, яка точка належить до якої грані (помаранчева точка на зображенні є 
початком координат об'єкта). 

 
6. Доступ до Засобів Сітей – Accessing Mesh Tools. 
Ці засоби трансформ доступні у секції «Трансформа» – Transform меню 

«Сіть» – Mesh у заголовку. Зауважте, що деякі з них можуть також 
використовуватися на інших редагованих об’єктах, як криві, поверхні та 
решітки. 

Засоби сітей знаходяться у різних місцях, а також доступні за допомогою 
скорочень. 

Меню – Menus 
Ці меню розміщуються у заголовку. Деякі з цих меню можуть бути 

доступні за допомогою скорочень: 

 Ctrl-F  викликає меню засобів Faces 

 Ctrl-E  викликає меню засобів Edges 

 Ctrl-V  викликає меню засобів Vertices 

 
6.1. Переміщення, Обертання, Масштабування – Move, Rotate, Scale 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Tool 

Toolbar ‣ Move, Rotate, Scale  

Меню – Menu 



Mesh ‣ Transform ‣ Move, Rotate, Scale  

Скорочення – Hotkey 

G , R , S  

Як тільки ви маєте вибрання одного чи більше елементів ви можете 

переміщати G , обертати R  або масштабувати S  їх, як і багато інших речей у 

Blender’і, як описано у секції Manipulation in 3D Space. 
Для переміщення, обертання та масштабування вибраних компонентів 

використовуйте кнопки Move, Rotate та Scale, гізмо трансформ – transform 

gizmos, або скорочення: G , R , and S  відповідно. 

Після переміщення вибрання опції у панелі Наладнати Останню Операцію 
– Adjust Last Operation дозволяють вам тонко підлаштовувати ваші зміни, 
лімітувати ефект певними осями, вмикати та вимикати Пропорційне Редагування 
– Proportional Editing тощо. 

Звичайно, коли ви переміщуєте елемент певного типу (наприклад, ребро), 
то ви також модифікуєте неявно пов’язані з ним елементи інших видів 
(наприклад, вершини та грані). 

Натискання двічі G  дає перехід до засобу Edge Slide або Vertex Slide, 

залежно від вибрання. 
Ви також маєте у Режимі Редагування – Edit Mode добавну опцію, коли 

використовуються ці базові маніпуляції: Пропорційне Редагування – Proportional 
Editing. 

Панель «Трансформа» – Transform 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Панель – Panel 

«регіон Боковини > Трансформа» – Sidebar region ‣ Transform  

Коли нічого не вибрано, то ця панель порожня. Коли більше ніж одна 
вершина вибрана, то редагуються усереднені значення та слово «Median» 
додається спереду до назв засобів. 

Вершина – Vertex 
Перші керувальники (X, Y, Z) показують координати вибраної вершини 

або серединної точки. 
Простір – Space 
Радіокнопки Простору дозволяють вам обирати, чи ці координати є 

відносними до початку об’єкта (Local) чи до глобального початку (Global). 
Глобально – Global, Локально – Local 
Дані Вершин – Vertex Data 
Вагомість Скосу – Bevel Weight 
Ця властивість ребра, значення між (0.0 до 1.0), використовується 

модифікатором «Скіс» – Bevel Modifier для керування інтенсивністю 
скошування сіті на вершинах, коли опція «Лише Вершини» – Only Vertices є 
активна. 

Дані Ребер – Edge Data 



Коли вибрано ребро, то доступні наступні опції. З’являється більше 
кнопок: 

Вагомість Скосу – Bevel Weight 
Дивіться тут – Edge bevel weight. 
Складка – Crease 
Значення складки – crease на цьому ребрі. 
Додання Геометрії – Adding Geometry 
 

6.2. Дублювати або Видавити до Курсора – Duplicate or Extrude to Cursor 
У Blender’і, для моделювання, ви маєте кілька способів додання елементів сіті. 

Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Скорочення – Hotkey 

Ctrl-LMB  

Інтерактивно поміщає нові вершини за допомогою Ctrl-LMB  у позицію 

курсора миші. 
 
6.2.1. Створювання Вершин – Creating Vertices 
Найбільш базовий елемент, вершина, може додаватися за допомогою 

клацання Ctrl-LMB , коли жодні інші вершини не вибрані. Оскільки простір 

камери (екран комп’ютера) є двовимірним, то Blender не може визначати усі три 
координати вершини на основі одиничного клацання мишею, а тому нова 
вершина поміщається на глибині 3D курсора. 

Для створення взаємопов’язаних вершин ви можете додати вершину та 

продовжувати робити наступні операції Ctrl-LMB  з однією останньо вибраною 

вершиною. Це буде пов’язувати останньо вибрану вершину з вершиною, 
створюваною у позиції миші, ребром (Дивіться Ілюстрацію Додання вершин 
одна за одною.), та буде продовжувано з’єднувати їх при створенні вершин, якщо 
ви продовжуєте повторювати цю операцію 

 
Додання вершин одна за одною. 
 
 
 



6.2.2. Створювання Граней – Creating Faces 

 
Чотирибічник з Ребра з автоматичним обертанням джерела. 

Якщо ви вибрали дві вершини, що вже з’єднані ребром, то клацання Ctrl-

LMB  створить площинну грань, також відому як чотирибічник. Blender буде 

слідувати за курсором вашої миші та використає площину вашого оглядвікна для 
створення чотирибічників. 

Для Ctrl-LMB  Blender буде автоматично обертати останнє вибране Ребро 

(джерело) для наступних операцій, якщо ви вже маєте принаймні одну грань 
створену, ділячи кути між ново створеним ребром та останніми двома ребрами, 
та створюючи згладжений кут між ними. Blender буде розраховувати цей кут, 
використовуючи останні додатну та від’ємну позиції останніх координат по X та 
Y та останнє з’єднане невибране ребро. Якщо цей кут перевищує від’ємний ліміт 
(за правилом квадранта) між останньо створеним ребром та останніми двома 
ребрами, то Blender буде загортати грані. Але якщо ви не хочете, щоб Blender 

обертав та згладжував кути автоматично при видавленні з Ctrl-LMB , то ви 

можете також стримувати Blender від обертання джерел за допомогою Shift-

Ctrl-LMB . У цьому випадку Blender не буде обертати джерело, ділячи кут між 

цими ребрами при створенні грані. 
Для обох випадків Blender буде інформувати користувача про обертання 

джерела у ході процесу створення. Якщо ви поглянете на панель Наладнати 

Останню Операцію – Adjust Last Operation та натиснете Ctrl-LMB , ви побачите, 

що «Обертати Джерело» – Rotate Source автоматично увімкнено, і якщо 

використовується Shift-Ctrl-LMB , то воно буде автоматично вимкнено. 

Якщо ви маєте три або більше вершин вибрані та клацаєте Ctrl-LMB , то 

ви також будете створювати площинні грані, але уздовж цих вибраних вершин, 
слідуючи у напрямку курсора. Ця операція є подібною до операції видавлення, 
яка пояснюється тут – Extrude. 

6.2.3. Видалення та Розчинювання – Deleting & Dissolving 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Сіть > Видалення» – Mesh ‣ Delete  

Ці засоби можуть використовуватися для вилучення компонентів. 



Видалення – Delete 
Орієнтир – Reference 
Скорочення – Hotkey 

X , Delete  

Видаляє вибрані вершини, ребра або грані. Ця операція може також 
обмежуватися: 

Вершини – Vertices 
Видаляє усі вершини у поточному вибранні, вилучаючи будь-які грані або 

ребра, що з ними з’єднані. 
Ребра – Edges 
Видаляє будь-які ребра у поточному вибранні. Вилучає будь-які грані, для 

яких ці ребра спільно використовуються. 
Грані – Faces 
Вилучає будь-які грані у поточному вибранні. 
Лише Ребра і Грані – Only Edges & Faces 
Лімітує дану операцію тільки вибраними ребрами та суміжними гранями. 
Лише Грані – Only Faces 
Вилучає грані, але ребра у межах вибрання граней зберігаються. 
Розчинення – Dissolve 
Операції розчинення також доступні з меню Delete. Розчинення буде 

вилучати геометрію та заповняти згідно з навколишньою геометрією. Замість 
вилучення геометрії, що може залишати отвори, які вам доведеться заповнювати 
знову. 

Вилучає вибрану геометрію, але без створення отворів, ефективно 
перетворюючи виділ в одиничний N-бічник. Розчинення працює дещо по-
різному залежно від того, чи вибраними є ребра, грані або вершини. Ви можете 
додавати деталізацію при потребі або швидко вилучати її, там де вона не 
потрібна. 

Розчинити Вершини – Dissolve Vertices 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Сіть > Видалення > Розчинити Вершини» – Mesh ‣ Delete ‣ Dissolve  

Vertices  

Вилучає вершину, об’єднуючи усі навколишні грані. У випадку двох ребер 
зливає їх в одне ребро. 

Розділ Грані – Face Split 
При розчиненні вершин у навколишніх гранях ви можете часто отримувати 

дуже великі нерівні N-бічники. Опція Face Split лімітує розчинення 
використанням тільки кутків граней, з’єднаних з даною вершиною. 

Рвані Рубежі – Tear Boundaries 
Відділяє кутки граней замість об’єднання граней. 
Приклади – Examples 



 
1) Оригінальна сіть. 2) Face Split: Вимк, Tear Boundaries: Вимк. 3) Face 

Split: Увім, Tear Boundaries: Увім. 4) Face Split: Увім/Вимк, Tear Boundaries: 
Увім. 

Розчинити Ребра – Dissolve Edges 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Сіть > Видалення > Розчинити Ребра» – Mesh ‣ Delete ‣ Dissolve Edges  

Вилучає ребра, що спільно використовуються двома гранями (сполучаючи 
ці грані). 

Опції такі ж самі, як і для засобу Dissolve Vertices. 
Розчинити Грані – Dissolve Faces 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Сіть > Видалення > Розчинити Грані» – Mesh ‣ Delete ‣ Dissolve Faces  

Зливає регіони граней, що спільно використовують ребра, в одну грань. 
Примітка 

Це може бути доступно швидко за допомогою клавіші F , 

дивіться: Розчинення Наявних Граней – Dissolve Existing Faces. 
Розчинення (Чутливе до Контексту) – Dissolve (Context-Sensitive) 
Орієнтир – Reference 
Скорочення – Hotkey 

Ctrl-X  

Це зручне скорочення, що розчиняє на основі поточного режиму вибрання 
(вершина, ребро, грань). 

Лімітоване Розчинення – Limited Dissolve 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

Mesh ‣ Delete ‣ Limited Dissolve  

Цей засіб може спрощувати вашу сіть шляхом розчинення вершин та 



ребер, виокремлюючи плоскі регіони. 

 
Оригінальна сіть. 

 
Результат від Limited Dissolve. 

Макс Кут – Max Angle 
Скорочує детальність на площинних гранях та лінеарно, прямолінійно 

розташованих ребрах за допомогою налагоджуваного порогу кута. 
Усі Рубежі – All Boundaries 
Завжди розчиняє вершини, що мають на рубежах ребра з двома 

користувачами. 
Розмежування – Delimit 
Запобігає сполученню граней, коли вони не мають спільних певних 

властивостей (наприклад, матеріалу). 
Стягнути Ребра – Edge Collapse 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Сіть > Видалення > Стягнути Ребра» – Mesh ‣ Delete ‣ Edge Collapse  

Скорочення – Hotkey 

Alt-M , Collapse  

Зливає кожне ребро в окремі вершини. Це корисно для стягнення кільця 
ребер шляхом вилучення петлі граней, що проходить між ними. 

 
Вибране кільце ребер. 

 
Стягнення кільця ребер. 

 
 



Edge Loops 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode (режими вибору Вершин – Vertex або 

Ребер – Edge) 
Меню – Menu 

Mesh ‣ Delete ‣ Edge Loops  

Скорочення – Hotkey 

X  or Delete , Edge Loops  

Edge Loop – «Петля Ребер» дозволяє вам видаляти вибрану петлю ребер, 
якщо вона знаходиться між іншими двома петлями ребер. Це створюватиме одну 
петлю граней там, де існували дві попередні. 

Примітка 
Опція Edge Loop дуже відрізняється від опції Edges, навіть якщо ви 

використовуєте її на ребрах, що виглядають як петля ребер. Видалення петлі 
ребер об’єднує навколишні грані, зберігаючи поверхню сіті. При видаленні 
ланцюга ребер, ці ребра вилучаються, видаляючи також навколишні грані. Це 
буде залишати отвори у сіті там, де колись були ці грані. 

Приклад – Example 
Вибрана петля ребер на Сфері UV була видалена і грані були об’єднані з 

навколишніми ребрами. Якщо ці ребра були б видалені шляхом вибору 
пункту Edges з меню Delete, то залишилася б порожня смужка видалених граней 
по всьому шляху навколо сфери, натомість. 

 
Вибрана петля ребер. 

 
Видалена петля ребер. 

 
6.2.4. Зробити Ребро/Грань – Make Edge/Face 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Вершина > Нове Ребро/Грань з Вершин» - Vertex‣New Edge/Face from Vertices  

Скорочення – Hotkey 



F  

Це чутливі до контексту засіб, який створює геометрію, заповнюючи 
вибрання. При вибранні лише двох вершин це буде створювати ребро, в інших 
випадках будуть створюватися грані. 

Типовий випадок використання – вибрати вершини та натиснути F , однак, 

Blender також підтримує створення граней з різних виділів, що допомагає 
швидко вибудовувати геометрію. 

Методи – Methods 
Наступні методи використовуються автоматично, залежно від контексту. 
Ізольовані Вершини – Isolated Vertices 

 
Перед. 

 
Після. 

Ізольовані Ребра – Isolated Edges 

 
Перед. 

 
Після. 

N-бічник з Ребер – N-gon from Edges 
При вибранні багатьох ребер Blender буде робити N-бічник. Зауважте, що 

це не підтримує отвори, для підтримки отворів вам необхідно використати засіб 
граней Заповнення – Fill. 



 
Перед. 

 
Після. 

Суміш Вершин/Ребер – Mixed Vertices/Edges 
Наявні ребра використовуються для зроблення грані, а також додаткова 

вершина. 

 
Перед. 

 
Після. 

Мережа Ребер – Edge-Net 
Інколи ви маєте багато з’єднаних ребер без внутрішніх граней. 

 
Перед. 

 
Після. 



Хмара Точок – Point Cloud 
При наявності вибраних багатьох ізольованих вершин Blender розрахує 

ребра для N-бічника. 

 
Перед. 

 
Після. 

Вибрання Одиничної Вершини – Single Vertex Selection 
При вибранні одиничної вершини на рубежі буде створена грань уздовж 

цього рубежу, що заощадить ручне вибирання інших двох вершин. Зверніть 
увагу, що цей засіб може виконуватися багато разів для продовжуваного 
створення граней. 

 
Розчинення Наявних Граней – Dissolve Existing Faces 
При наявності у вас вибраного регіону наявних граней створення грані на 

цьому вибранні буде вилучати спільно використовувані вершини та ребра, 
створюючи одиничну грань. 

6.2.5.Симетрія – Symmetry 
Підхоп до Симетрії – Snap to Symmetry 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Сіть > Підхоп до Симетрії» – Mesh ‣ Snap to Symmetry  

Засіб Snap to Symmetry дозволяє вам підхоплювати вершини сіті до їх 
дзеркалених аналогів. 

Корисно при роботі із сітями, які переважно симетричні, але мають 
вершини, які були переміщені досить так, що Blender не виявляє їх як дзеркалені 
(при увімкненій опції X Mirror, наприклад). 

Це може спричинятися випадково при редагуванні з вимкненою X Mirror. 



Інколи моделі, імпортовані з інших застосунків, є досить асиметричними, що 
дзеркалення також дає збій. 

Напрям – Direction 
Визначає вісь та напрям для підхоплення. Може бути однією з трьох осей, 

з додатного на від’ємний або з від’ємного на додатний. 
Поріг – Threshold 
Визначає радіус пошуку для використання при пошуку відповідних 

вершин. 
Фактор – Factor 
Підтримка для змішування дзеркалених локацій з одного боку на інший 

(0.5 – це рівний мікс обох). 
Центр – Center 
Підхоплюються вершини уздовж центральної осі до нуля. 

 
Перед Snap to Symmetry. 

 
Після Snap to Symmetry. 

Симетризування – Symmetrize 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Сіть > Симетризація» – Mesh ‣ Symmetrize  

Засіб Symmetrize – це швидкий спосіб зробити сіть 
симетричною. Symmetrize працює шляхом розрізання сіті в опорній точці 
об’єкта, дзеркалення геометрії через у по вказаній осі та об’єднання двох 
половин разом (якщо вони з’єднані). Також копіюються дані сіті з однієї сторони 
на іншу: наприклад, UVи, кольори вершин, вагомості вершин. 

Напрям – Direction 
Визначає вісь та напрям для ефекту. Може бути однією з трьох осей, з 

додатного на від’ємний або з від’ємного на додатний. 
Поріг – Threshold 
Вершини у цьому діапазоні будуть підхоплюватися до площини симетрії. 



 
Сіть перед Symmetrize. 

 
Сіть після Symmetrize. 

 
Засоби Вершин – Vertex Tools 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Вершина» – Vertex  

Скорочення – Hotkey 

Ctrl-V  

Інструменти, які працюють переважно з вибором вершин, але деякі також 
працюють з вибором ребер або граней. 

Зливання – Merging 
Зливання Вершин – Merging Vertices 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Вершина > Злиття» – Vertex ‣ Merge… , «Контекстне Меню > Злиття» 

– Context Menu ‣ Merge  

Скорочення – Hotkey 

Alt-M  

Цей засіб дозволяє вам зливати усі вибрані вершини в єдину одну, 
розчиняючи всі інші. Ви можете обирати локацію результатної вершини у 
спливному меню, що з’являється після запуску цієї команди: 

До Першої – At First 
Доступно тільки у режимі вибору Vertex, поміщає результатну вершину у 

локацію першої з вибраних. 
До Останньої – At Last 
Доступно тільки у режимі вибору Vertex, поміщає результатну вершину у 

локацію останньої з вибраних (активної вершини). 
До Центра – At Center 
Доступно у всіх режимах вибору, поміщає результатну вершину у центр 



вибрання. 
До Курсора – At Cursor 
Доступно у всіх режимах вибору, поміщає результатну вершину у поточне 

місце 3D Курсора. 
Стягнення – Collapse 
Кожен острів вибраних вершин (з’єднаних вибраними ребрами) буде злито 

в його серединному центрі і залишиться по одній вершині на острів. Це також 

доступно через опцію меню «Сіть > Ребра > Стягнення» – Mesh ‣ Edges ‣  

Collapse … 

Зливання вершин, звичайно ж, також видаляє деякі ребра та грані. Але 
Blender буде робити все можливе для збереження ребер та граней, що лише 
частково задіяні в об’єднанні. 

Примітка 
At First та At Last залежить від збереженого порядку вибрання: цей порядок 

втрачається, наприклад, після зміни режиму вибрання. 
UVи – UVs 
Якщо UVs увімкнено у панелі the Наладнати Останню Операцію – Adjust 

Last Operation, то координати розкладання UV, якщо наявні, будуть скориговані 
для запобігання спотворенню зображення. 

Злити за Відстанню – Merge by Distance 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Вершина > Злити за Відстанню» – Vertex ‣ Merge by Distance , 

«Контекстне Меню > Злити за Відстанню» – Context Menu ‣ Merge by Distance  

Merge by Distance є корисним засобом для спрощення сіті шляхом зливання 
вибраних вершин, що є ближче, ніж вказана відстань між ними. Альтернативним 
шляхом спростити сіть є вживання модифікатора «Спрощення» – Decimate 
Modifier. 

Відстань Злиття – Merge Distance 
Задає поріг відстані для зливання вершин. 
Невибране – Unselected 
Дозволяє вершинам у вибранні бути злитими з невибраними вершинами. 

При вимкненні, вибрані вершини будуть злиті лише з іншими вибраними. 
Відокремлення – Separating 
Розірвати Регіон – Rip Region 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Вершина > Розірвати Вершини» – Vertex ‣ Rip Vertices  

Скорочення – Hotkey: V  

Rip створює «отвір» у сіті, роблячи копію вибраних вершин та ребер зі 



збереженням з’єднання до сусідніх не-вибраних вершин, так що нові ребра є 
границями граней на одній стороні, а старі – границями граней на іншій стороні 
розриву. 

Приклади – Examples 

 
Вибрана вершина. 

 
Отвір, створений після використання 
Rip на вершині. 

 
Вибрані ребра. 

 
Результат розриву вибрання ребер. 

 
Складне вибрання вершин. 

 
Результат операції Rip. 

Обмеження – Limitations 
Rip працює лише, коли вибрані ребра та/або вершини. Використання цього 

засобу, коли вибраною є грань (явно чи неявно), поверне повідомлення про 
помилку «Cannot perform ripping with faces selected this way» – «Неможливо 



здійснити розривання з гранями, вибраними таким чином». Якщо ваше вибрання 
включає деякі ребра або вершини, що не знаходяться «між» двома розгортними 
– manifold гранями, то це також дасть збій з повідомленням «No proper selection 
or faces include» – «Немає належного вибору або включено грані». 

Розірвати Вершини та Заповнити – Rip Vertices and Fill 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Вершина > Розірвати Вершини та Заповнити» – Vertex ‣ Rip Vertices and  

Fill  

Скорочення – Hotkey 

Alt-V  

Rip Fill працює так само, як і вище згаданий засіб Rip, але замість 
залишення отвору, він заповнює проміжок геометрією. 

 
Вибрані ребра. 

 
Результат від Rip Fill. 

Розділення – Split 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Сіть > Розділення» – Mesh ‣ Split  

Скорочення – Hotkey 

Y  

Розділяє (роз’єднує) вибрання від решти сіті. Граничне ребро будь-якого з 
невибраних елементів дублюється. 

Зауважте, що «копія» залишається точно у тій же позиції, що й оригінал, а 

тому ви повинні перемістити її за допомогою G , щоб її чітко бачити… 

Розірвати Ребро – Rip Edge 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 



«Вершина > Розірвати Вершини та Розширити» – Vertex ‣ Rip Vertices and  

Extend  

Скорочення – Hotkey 

Alt-D  

Цей засіб бере будь-яку кількість вибраних вершин та дублює і перетягує 
їх уздовж найближчого ребра за мишкою, При розширенні петлею ребер, 
розширяння відбувається на вершинах у кінцевих точках такої петлі. Подібна 
поведінка у засобу Extrude, але це створює n-бічник. 

Він допомагає легко додавати деталі до наявних ребер. 
Відокремлення – Separate 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Сіть > Відокремлення» – Mesh ‣ Separate  

Скорочення – Hotkey 

P  

Засіб Separate буде відділяти Split елементи сіті в інший сітьовий об’єкт. 
Вибрання – Selection 
Відокремлює вибрані елементи. 
За Матеріалом – By Material 
Відокремлює фрагменти на основі призначених різним граням матеріалів. 
За Незв’язаними Частинами – By loose parts 
Створює по одному об’єкту для кожного незалежного (роз’єднаного) 

фрагмента оригінальної сіті. 
Ковзання Вершини – Vertex Slide 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

Vertex ‣ Slide Vertices  

Скорочення – Hotkey 

Shift-V  

Vertex Slide буде трансформувати вершину уздовж одного з її суміжних 

ребер. Використовуйте Shift-V  для активування засобу. Найближча вибрана 

вершина під вказівником миші буде керувальною. Переміщуйте мишу уздовж 
напрямку бажаного ребра для вказання позиції вершини. Потім 

натисніть LMB  для підтвердження цієї трансформації. 

Рівно – Even E  

Стандартно значення зсуву вершин є відсотком довжин ребер, уздовж яких 
вони переміщуються. Коли режим Even активний, то вершини зміщуються на 
абсолютне значення. 



Перевернуто – Flipped F  

Коли Flipped активний, то вершини переміщуються на однакову відстань 
від суміжних вершин, замість переміщування від їх оригінальної позиції. 

Затиск – Clamp Alt  або C  

Перемикає затискання ковзання у межах розширяння ребер. 

 
Вибрана вершина. 

 
Позиціювання вершини 
інтерактивно. 

 
Перепозиційована 
вершина. 

Згладження на Вершинах – Smooth Vertex 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Вершина > Згладити Вершини» – Vertex ‣ Smooth Vertices , «Контекстне 

Меню > Згладження» – Context Menu ‣ Smooth  

Це застосує один раз засіб «Згладження» – Smooth Tool. 
Опукла Оболонка – Convex Hull 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Сіть > Опукла Оболонка» – Mesh ‣ Convex Hull  

Оператор Convex Hull приймає хмару точок як увід та виводить опуклу 
оболонку навколо цих вершин. Якщо увід містить ребра або грані, що лежать на 
такій опуклій оболонці, вони можуть також бути використані у виводі. Цей 
оператор може використовуватися також як засіб мостіння. 

 
Увідна сіть, хмара точок та результат від Convex Hull. 
Видалити Невживане – Delete Unused 



Вилучає вершини, ребра та грані, що були вибрані, але не використані як 
частина оболонки. Зверніть увагу, що вершини та ребра, які використовуються 
іншими ребрами та гранями, що не є частиною вибору, не будуть видалені. 

Вжити Наявні Грані – Use Existing Faces 
При можливості використовує для уводу наявні грані, що лежать на 

оболонці. Це дозволяє виводу опуклої оболонки містити скоріше N-бічники, а не 
трикутники (або чотирибічники, якщо увімкнена опція Join Triangles). 

Зробити Отвори – Make Holes 
Видаляє ребра та грані в оболонці, що також були частиною уводу. 

Корисно у таких випадках, як мостіння для видалення граней між наявною сіттю 
та опуклою оболонкою. 

Сполучити Трикутники – Join Triangles 
Сполучає суміжні трикутники у чотирибічники. Має усі такі ж властивості 

як і оператор Tris to Quads (ліміт кута, порівняти UVи тощо). 
Макс Кут Грані – Max Face Angle, Макс Кут Форми – Max Shape Angle, 

Порівняння – Compare 
Дивіться Трикутники у Чотирикутники – Triangles to Quads. 
Зробити Приріднення до Вершин – Make Vertex Parent 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Вершина > Зробити Приріднення до Вершин» – Vertex ‣ Make Vertex  

Parent  

Скорочення – Hotkey 

Ctrl-P  

Це приріднить інші вибрані об’єкт(и) до вибраних вершин/ребер/граней, як 
описано here. 

Додання Гачка – Add Hook 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Вершина > Гачки» – Vertex ‣ Hooks  

Скорочення – Hotkey 

Ctrl-H  

Додає модифікатор «Гачок» – Hook Modifier (використовуючи для цього 
нову порожню Empty або поточно вибраний об’єкт), пов’язуючи його з 
вибранням. Зауважте, що хоча ця дія і показується у меню історії, вона не може 
бути скасована у режимі Edit Mode – оскільки вона залучає інші об’єкти… 

Коли поточний об’єкт не має жодних асоційованих гачків, тільки 2 перші 
опції будуть показуватися у цьому меню. 

Зачепити за Новий Об’єкт – Hook to New Object 
Створює новий модифікатор Hook для активного об’єкта та призначає його 

для вибраних вершин; він також створює порожню у центрі цих вершин, до якого 



він їх зачіпляє. 
Зачепити за Вибраний Об’єкт – Hook to Selected Object 
Робить, що й Hook to New Object, але натомість зачіплювання вершин до 

нової порожні, він зачіпляє їх до вибраного об’єкта (якщо такий існує). Тут 
повинен бути тільки один вибраний об’єкт (окрім редагованої сіті). 

Зачепити за Вибрану Кістку Об’єкта – Hook to Selected Object Bone 
Робить так само, як і Hook to New Object, але задає останню вибрану кістку 

у також вибраній арматурі як ціль для модифікатора. 
Призначити у Зачеплення – Assign to Hook 
Вибрані вершини призначаються у вказане зачеплення. Щоб це сталося, 

показується список зачеплень, асоційованих з цим об’єктом. Усі невибрані 
вершини вилучаються з нього (якщо вони були призначені у таке конкретне 
зачеплення). Одна вершина може бути призначена у більше, ніж одне, 
зачеплення. 

Вилучити Зачеплення – Remove Hook 
Вилучає вказане зачеплення (з показуваного списку) з даного об’єкта: 

конкретний модифікатор Hook вилучається зі стека модифікаторів. 
Вибрати Зачеплення – Select Hook 
Вибирає усі вершини, призначені у вказане зачеплення (зі списку 

зачеплень). 
Скинути Зачеплення – Reset Hook 
Це еквівалент кнопці Reset на панелі конкретного модифікатора Hook 

(вибране зі списку зачеплень). 
Перецентрувати Зачеплення – Recenter Hook 
Це еквівалент кнопки Recenter на панелі конкретного модифікатора Hook 

(вказане у списку зачеплень). 
Змішання З Форми – Blend From Shape, Поширити Форми – Propagate 

Shapes 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Вершина > Змішання З Форми» – Vertex ‣ Blend From Shape  та «Вершина 

> Поширити Форму» – Vertex ‣ Shape Propagate  

Ці опції стосуються ключів форм – shape keys. 
Поширити Форму – Shape Propagate 
Застосовує локації вибраних вершин до усіх інших ключів форм. 
Змішання З Форми – Blend From Shape 
Змішує дану форму з ключем форми. 
 
 
6.3. Засоби Ребер – Edge Tools 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 



«Ребро» – Edge  

Скорочення – Hotkey 

Ctrl-E  

Нове Ребро/Грань з Вершин – New Edge/Face from Vertices 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Вершина > Нове Ребро/Грань з Вершин» – Vertex ‣ New Edge/Face from  

Vertices  

Скорочення – Hotkey 

F  

Це створить ребро або деякі грані, залежно від вашого вибрання. 
Дивіться також Creating Geometry. 
Установлення Атрибутів Ребер – Set Edge Attributes 
Ребра можуть мати кілька різних атрибутів, що впливають на те, як певні 

інші інструменти впливають на сіть. 
Позначити Шов та Зчистити Шов – Mark Seam and Clear Seam 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Ребро > Позначити Шов/Зчистити Шов» – Edge ‣ Mark Seam/Clear Seam  

Шви – це спосіб створення відокремлень, «островів» в розкладках UV. 
Дивіться детальніше UV Mapping section. Ці оператори задають або вимикають 
цей стяг для вибраних ребер. 

Позначити Гостроту та Зчистити Гостроту – Mark Sharp and Clear 
Sharp 

Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Ребро > Позначити Гостроту/Зчистити Гостроту» – Edge ‣ Mark  

Sharp/Clear Sharp  

Стяг Sharp використовується розділеними нормалями – split normals там 
модифікатором «Розділ Ребром» – Edge Split, який є частиною технік 
згладжування/кастомізованого згладжування. Як і шви, це властивість ребер, і ці 
оператори вмикають або вимикають її для вибраних ребер. 

Наладнання Вагомості Скосу – Adjust Bevel Weight 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 



«Ребро «Вагомість Скосу Ребра» – Edge ‣ Edge Bevel Weight  «регіон 

Боковини > Трансформа > Вагомість Скосу Ребра» – Sidebar region ‣ Transform  

‣ Edge Bevel Weight  

Ця властивість ребра, значення між (0.0 до 1.0), використовується 
модифікатором «Скіс» – Bevel Modifier для керування інтенсивністю 
скошування сіті на ребрах. Це оператор входить в інтерактивний режим (дещо 
подібно до засобів трансформ), де шляхом переміщення миші (або уводу 
значення з клавіатури) ви можете задати вагомість скосу на вибраних ребрах. 
Якщо два або більше ребер вибрано, то цей оператор змінює усереднену 
вагомість ребер. 

Дивись також 
Вершини також мають вагомість скосу, яка може редагуватися. 
Складка на Ребрі – Edge Crease 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Ребро > Складка на Ребрі» – Edge ‣ Edge Crease  «регіон Боковини > 

Трансформа > Складка на Ребрі» – Sidebar region ‣ Transform ‣ Edge Crease  

Скорочення – Hotkey 

Shift-E  

Ця властивість ребра, значення між (0.0 до 1.0), використовується 
модифікатором «Підподілення Поверхні» – Subdivision Surface Modifier для 
керування гостротою ребер у підподіленій сіті. Це оператор входить в 
інтерактивний режим (дещо подібно до засобів трансформ), де шляхом 
переміщення миші (або уводу значення з клавіатури) ви можете задати 
(усереднене) значення складки на вибраних ребрах. Від’ємне значення буде 
віднімати від фактичного значення складки, якщо таке наявне. Для зчищення 
властивості складки на ребрі уводьте значення -1. 

Ковзання Ребра – Edge Slide 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Ребро > Ковзання Ребра» – Edge ‣ Edge Slide  

Ковзання одного або більше ребер по суміжних гранях з деякими 
обмеженнями задіює вибрання ребер (тобто, таке вибрання повинно визначати 
дійсну петлю, дивіться нижче). 

Рівно – Even E  

Змушує петлю ребер відповідати формі сусідньої петлі ребер. Ви можете 

перевернути на протилежну вершину, використовуючи F . Використовуйте Alt-

Wheel  для зміни керування ребрами. 



Перевернуто – Flipped F  

При активному режимі Even це перевертає між двома суміжними петлями 
ребер активну петлю ребер, яка повинна з ними узгоджуватися. 

Затиск – Clamp Alt  або C  

Перемикає затискання ковзання у межах розширяння ребер. 
Фактор – Factor 
Визначає величину здійсненого ковзання. Від’ємні значення відповідають 

ковзанням у напрямку однієї грані, тоді як додатні – у напрямку іншої. Це також 
показується у заголовку 3D Огляду. 

Дзеркальне Редагування – Mirror Editing 
Дозволяє вам поширювати цю операцію на симетричні елементи сіті (якщо 

такі присутні, у локальному напрямку X). 
Коригування UV – Correct UVs 
Коригує відповідні координати UV, якщо такі існують, для запобігання 

спотворенням зображення. 
Використання – Usage 
Стандартно, позиція вершин на петлі ребер рухається як відсоток від 

відстані між їх оригінальною позицією та суміжною петлею ребер, незалежно від 
довжини ребер. 

 
Вибрана петля ребер. 

 
Перепозиційована петля ребер. 

Режим «Рівно» – Even Mode 
Режим Even утримує форму вибраної петлі ребер такою ж, як у суміжної з 

неї петлі ребер, а не ковзає з відсотком уздовж кожного перпендикулярного 
ребра. 

У режимі Even цей засіб показує позицію уздовж довжини поточно 
вибраного ребра, яке позначається жовтим, від вершини, що має збільшену 
червону мітку. Переміщення ковзальної петлі ребер обмежується цією 
довжиною. При русі вами мишею вказівник довжини у заголовку змінюється, 
показуючи, де уздовж довжини ребра ви знаходитеся. 

Для зміни керувального ребра, що визначає позицію петлі ребер, 

використовуйте Alt-Wheel  для прокрутки до іншого ребра. 



 
Режим Even увімкнено. 

 
Режим Even з увімкненою 

Flip. 

Рухання миші переміщує вибрану петлю ребер у напрямку до або від 
стартової вершини, але лінія петлі буде рухатися тільки у межах довжини 
поточно вибраного ребра, відповідаючи формі однієї з межових петель ребер. 

Обмеження та Обходи – Limitations & Workarounds 
Існують обмеження щодо типу вибрання ребер для цієї операції. Хибними 

вибраннями є: 
Петля, що перетинає себе – Loop crosses itself 
Це означає, що даний засіб не зміг знайти підхожих граней, що є 

суміжними з вибраними ребром(ами). Приклад, що показує це є вибиранням двох 
ребер, що спільно використовують одну і ту ж грань. Грань не може бути 
суміжною сама собі. 

Кілька одночасно петель ребер – Multiple edge loops 
Вибрані ребра не є в одній і тій же петлі ребер, а це означає, що вони не 

мають спільного краю. Ви можете мінімізувати цю помилку, завжди вибираючи 
ребра з кінця у кінець або у «ланцюгу». Якщо ви вибираєте кілька одночасно 
ребер, переконайтеся, що вони з’єднані між собою. Це зменшить можливість 
отримання помилок зациклення. 

Ребра Границі – Border Edges 
Коли одиничне ребро було вибрано на односторонньому об’єкті. Петля 

ребер не може бути знайдена, оскільки тут є тільки одна грань. Пам’ятайте, що 
петлі ребер є петлями, що є відтинками двох або більше граней. 

Загальне правило тут – якщо вибрано кілька одночасно ребер, то вони 
повинні бути з’єднані кінцями так, щоб формувати безперервний ланцюг. 
Це буквально загальне правило, оскільки ви можете все ще вибирати ребра у 
ланцюгу, що є недійсним через те, що деякі з ребер у цьому ланцюгу входять у 
різні петлі ребер. 

Обернути Ребро – Rotate Edge 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Ребро > Обернути Ребро за ГС / Обернути Ребро проти ГС» – Edge ‣  



Rotate Edge CW / Rotate Edge CCW  

Обертання ребра за годинниковою стрілкою – clockwise (CW) або проти 
годинникової стрілки – counter-clockwise (CCW) обкручує ребро між двома 
гранями навколо їх вершин. Це дуже корисно для реструктурування топології 
сіті. 

Цей засіб оперує на вибраних ребрах або спільно використовуваному ребрі 
між вибраними гранями. 

 
Вибране ребро. 

 
Ребро, обернуте за ГС. 

Розділ Ребром – Edge Split 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Ребро > Розділ Ребром» – Edge ‣ Edge Split  

Edge Split подібний до засобу «Розрив» – Rip. Коли вибрано два або більше 
дотичні внутрішні ребра чи граничне ребро та використано Edge Split, то 
створиться отвір, дірка, а вибрані ребра здублюються для формування границі 
цього отвору. 

 
Вибрані ребра. 

 
Суміжна грань переміщена для викриття 
отвору, залишеного розділом. 

Мостити Петлі Ребер – Bridge Edge Loops 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 



«Ребро > Мостити Петлі Ребер» – Edge ‣ Bridge Edge Loops  

Bridge Edge Loops з’єднує одночасно кілька петель ребер гранями між ними. 
З’єднати Петлі – Connect Loops 
Відкрита Петля – Open Loop 
Петлі з’єднуються з відкритими кінцями. 
Закрита Петля – Closed Loop 
Намагається з’єднати у кругову петлю (де старт і кінець зливаються). 
Пари петель – Loop pairs 
З’єднує кожну пару однаковою кількістю петель індивідуально. 
Злиття – Merge 
Зливає петлі ребер, а не створює нову грань. 
Фактор Злиття – Merge Factor 
Які ребра петель ребер будуть злиті, значення 0.5 дасть злиття у точці на 

півдорозі. 
Кручення – Twist 
Визначає, які вершини в обох петлях з’єднуються одна з одною. 
Кількість Розрізів – Number of Cuts 
Кількість проміжних петель ребер, використовуваних для мостіння 

відстані між двома петлями. 
Інтерполяція – Interpolation 
Лінеарно – Linear, Шлях Змішання – Blend Path, Поверхня Змішання – 

Blend Surface 
Згладженість – Smoothness 
Згладженість для Blend Path та Blend Surface. 
Фактор Профілю – Profile Factor 
Наскільки проміжні нові ребра звужуються/розширюються. 
Форма Профілю – Profile Shape 
Форма нових ребер. Дивіться сторінку Proportional Editing щодо опису 

кожної опції. 
Приклади – Examples 
Простий приклад, що показує дві закриті петлі ребер. 

 
Увід. 

 
Результат мостіння. 

Приклад засобу Bridge між петлями ребер з різними кількостями вершин. 



 
Увід. 

 
Результат мостіння. 

Приклад використання засобу Bridge для вирізання отворів у вибраннях 
граней та з’єднання їх. 

 
Увід. 

 
Результат мостіння. 

Приклад, що показує як засіб Bridge може виявляти кілька одночасно 
петель та з’єднувати їх за один крок. 

 
Увід. 

 
Результат мостіння. 

Приклад опції підподілення та змішування поверхні з UV. 



 
Увід. 

 
Результат мостіння. 

6.4. Засоби Граней – Face Tools 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Грань» – Face  

Скорочення – Hotkey 

Ctrl-F  

Це засоби, які маніпулюють гранями. 
Заповнення – Fill 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Грань > Заповнення» – Face ‣ Fill  

Скорочення – Hotkey 

Alt-F  

Опція Fill створюватиме трикутні грані з будь-якої групи вибраних ребер 
або вершин, допоки вони формують один чи кілька завершених периметрів. 

Красиво – Beauty 
Впорядковуються нові трикутники красиво. 



 
Заповнено за допомогою Fill. 
Зауважте, на відміну від створення N-бічників, Fill підтримує отвори. 

 
Закритий периметр ребер з 

отворами. 
 

Заповнено за допомогою Fill. 

Покращити Грані – Beautify Faces 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Грань > Покращити Грані» – Face ‣ Beautify Faces  

Beautify Faces працює тільки на вибраних вже наявних гранях. Він 
перевпорядковує вибрані трикутники для отримання більш «збалансованих» 
(тобто, менш довгих тонких трикутників). 

Макс Кут – Max Angle 
Опція розмежування кута для лімітування обертання ребер до плоских 



поверхонь. 

 
Текст, конвертований у сіть. 

 
Результат від Beautify Faces. 

Заповнити Сіткою – Grid Fill 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Грань > Заповнити Сіткою» – Face ‣ Grid Fill  

Grid Fill використовує пару з’єднаних петель ребер або одиничну, закриту 
петлю ребер для заповнення сіткою граней, орієнтуючись на форму 
навколишньої геометрії. 

Найкращий передбачуваний результат може бути досягнуто, якщо ви 
вибираєте дві протилежні петлі ребер з однаковою кількістю вершин. Коли 
одинична закрита петля ребер вибрана, то опції Span/Offset дозволяють вам 
наладнати спосіб, якими дві протилежні петлі ребер виявляються з однієї 
закритої петлі ребер. 

Відтинок – Span 
Визначає кількість стовпців у сітці. 
Зсув – Offset 
Визначає вершину, що вважається кутком сітки, стандартно – це активна 

вершина. Offset дозволяє вам обертати лінії сітки. 
Просте Змішування – Simple Blending 
Використовується простий алгоритм інтерполяції для генерування вершин 

сітки з петель рубежів, який не намагається підтримувати форму, корисно для 
плоских поверхонь або коли утримування форми дає дивні результати. 



 
Увід. 

 
Результат від Grid Fill. 

Потовщення – Solidify 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Грань > Потовщення Граней» – Face ‣ Solidify Faces  

Це бере вибрання граней та потовщує їх, видавлюючи їх рівномірно для 
надання об’єму не-розгортній – non-manifold поверхні. Це також доступно як 
модифікатор – Modifier. Після використання цього засобу ви можете задати 
відстань зсуву у панелі Наладнати Останню Операцію – Adjust Last Operation. 

Товщина – Thickness 
Величина зсуву ново створеної поверхні. Додатні значення зсувають цю 

поверхню всередину відносно до напрямку нормалей. Від’ємні значення 
зсувають назовні. 

 
Сіть перед операцією 
Solidify. 

 
Потовщення з 
додатною Thickness. 

 
Потовщення з 
від’ємною Thickness. 

Перетин – Intersect 
Перетин (Ніж) – Intersect (Knife) 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 



«Грань > Перетин (Ніж)» – Face ‣ Intersect (Knife)  

Цей засіб Перетину дозволяє вам різати перетини у геометрії. Це трохи 
схоже на інструмент «Булів» – Boolean, але не розраховує зовнішню/внутрішню 
сторони. Грані розділяються уздовж цих перетинів, залишаючи нові ребра 
вибраними. 

Джерело – Source 
Вибране/Невибране – Selected/Unselected 
Оперує вибраною або невибраною геометрією. 
Самоперетин – Self Intersect 
Обробляється перекривна геометрія сіті. 
Режим Відокремлення – Separate Mode 
All – Усе 
Розділяє геометрію по новому ребру. 
Різання – Cut 
Утримує кожну сторону перетину окремою без розділення граней навпіл. 
Злиття – Merge 
Зливає усю геометрію від перетину. 
Поріг Злиття – Merge Threshold 
Дивіться Intersect (Boolean). 
Перетин (Булів) – Intersect (Boolean) 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Грань > Перетин (Булів)» – Face ‣ Intersect (Boolean)  

Здійснює булеві операції з вибранням на невибраній геометрії. 
Хоча Модифікатор «Булів» – Boolean Modifier корисний для не-руйнівних 
редагувань, доступ до булевих за допомогою засобу у Режимі Редагування – Edit 
Mode може бути корисним для швидкого здійснення редагувань. 

Булів – Boolean 
Різниця – Difference, Об’єднання – Union, Перетин – Intersect 
Обмін – Swap 
Змінює порядок операції. 
Поріг Злиття – Merge Threshold 
Допуск для закритих граней, щоб вони вважалися дотичними, Може бути 

корисно його збільшити, коли деякі самоперетини не виявляються, а повинні би 
були, та коли створюється додаткова геометрія через те, що не виявляється 
перекривання ребер. 

Каркас – Wireframe 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Грань > Дротяна Рама» – Face ‣ Wire frame  

Засіб Wireframe робить каркас із граней, перетворюючи ребра у трубки 



каркасу, подібно до Модифікатор «Каркас» – Wireframe Modifier. 
Випин Граней – Poke Faces 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Грані > Випин Граней» – Faces ‣ Poke Face  

Розділяє кожну з вибраних граней на віяло трикутників, створюючи нову 
центральну вершину та трикутники між ребрами оригінальної грані та новою 
центральною вершиною. Зсув – Offset може бути використано для створення 
шипів або поглиблень. 

Зсув Випину – Poke Offset 
Зсувається нова центральна вершина уздовж нормалі грані. 
Зсув Відносно – Offset Relative 
Множиться Offset на усереднену довжину від центру до вершин грані. 
Центр Випину – Poke Center 
Обчислює центр грані. 
Виважене Середнє – Weighted Mean 
Використовується середнє усереднення виваженого за довжиною ребра. 
Середнє – Mean 
Використовується середнє усереднення. 
Межі – Bounds 
Використовує центр габаритної коробки. 
Трикутникувати Грані – Triangulate Faces 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Грань > Трикутникувати Грані» – Face ‣ Triangulate Faces  

Скорочення – Hotkey 

Ctrl-T  

Це засіб конвертує кожну з вибраних граней (будь то чотирибічники чи n-
бічники) у трикутні грані. Дивіться Модифікатор «Трикутникування» – 
Triangulate Modifier. 

Трикутники у Чотирикутники – Triangles to Quads 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Грань > Трикутники у Чотирикутники» – Face ‣ Triangles to Quads  

Скорочення – Hotkey 

Alt-J  

Цей засіб конвертує вибрані трикутні грані у чотирикутні, беручи суміжні 
трикутники та вилучаючи спільне ребро для створення чотирибічника на основі 



порогу. Цей засіб може застосовуватися на вибранні з кількох одночасно 
трикутників. 

Це означає, що ви можете вибрати сіть повністю та конвертувати 
трикутники, що вже формують чотирибічні форми, у чотирибічники без потреби 
займатися індивідуальними гранями. 

Альтернативно ви можете силувати цю операцію вибирати пари граней 
(дивіться пораду нижче про інші способи сполучення). 

Для створення чотирибічної грані цей засіб потребує вибрання принаймні 
двох суміжних трикутних граней. Якщо ви маєте парну кількість вибраних 
трикутників, то можна також отримувати не тільки чотирибічники. Фактично, 
цей засіб намагається створити «квадратичні» чотирибічники, наскільки це 
можливо, із даних трибічних граней, а це означає, що деякі з трикутників можуть 
і залишатися. 

 
Перед конвертуванням 

трибічників у чотирибічники. 

 
Після конвертування 

трибічників у чотирибічники. 

Усі записи меню та скорочення використовують устави, визначені у 
панелі Operator: 

Макс Кут – Max Angle 
Це значення, між (0 до 180), керує порогом для цього засобу для роботи на 

суміжних трикутниках. З Threshold 0.0 він буде сполучати тільки суміжні 
трикутники, що формують ідеальний прямокутник (тобто, прямокутні 
трикутники, що сполучаються своїми гіпотенузами). Більші значення 
вимагаються для трикутників зі спільним ребром, що є невеликим, відносно 
розміру інших ребер цих трикутників. 

Порівняти UVи – Compare UVs 
При увімкненні, це запобігає об’єднанню трикутників, що також не є 

суміжними в активній розкладці UV. 
Порівняти Колір Вершин – Compare Vertex Color 
При увімкненні, це запобігає об’єднанню трикутників, що не мають 

однакових кольорів вершин. 
Порівняти Гостре – Compare Sharp 
При увімкненні, це запобігає об’єднанню трикутників, що спільно 

використовують ребро, позначене як гостре. 
Порівняти Матеріали – Compare Materials 



При увімкненні. це запобігає об’єднанню трикутників, що не мають 
однакового призначеного на них матеріалу. 

Звести Ребра у Грані – Weld Edges into Faces 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Грань > Звести Ребра у Грані» – Face ‣ Weld Edges into Faces  

Засіб для розділення вибраних граней незв’язаними вільними ребрами. Це 
може бути корисно подібно до засобу Knife, але такі ребра спершу укладаються 
вручну. 

Обертання Ребер – Rotate Edges 
Орієнтир – Reference 
Режим – Mode 
Режим Редагування – Edit Mode 
Меню – Menu 

«Грань > Обернути Ребро за ГС» – Face ‣ Rotate Edge CW  

Цей засіб функціонує так само, як і обертання ребра у режимі вибору Edge. 
Він працює на спільно використовуваному ребрі між двома гранями та обертає 
це ребро, якщо воно було вибране. 

 
Дві суміжні грані вибрано. 

 
Вибране ребро обернуто. 

Дивіться детальніше тут – Rotate Edge. 
Оберт і Розворот – Rotate & Reverse 
Обернути/Розвернути UV – Rotate/Reverse UVs 
Дивіться Дзеркалення Граней та Обертання UVт – Face Mirror & Rotate 

UVs. 
Обернути Кольори – Rotate Colors 
Обертає Кольори Вершин всередині граней за годинниковою стрілкою або 

проти годинникової стрілки. 
Розвернути Кольори – Reverse Colors 
Перевертає напрям Кольорів Вершин всередині вибраних граней. 
 
7. Модифікатори. 
Модифікатори – modifiers – це автоматичні операції, що впливають на 

геометрію об’єкта не-руйнівним способом. За допомогою модифікаторів ви 
можете реалізовувати багато ефектів автоматично, щоб інакше було надто 
втомливим робити вручну (наприклад, підподілення поверхонь), і без впливу на 



базову геометрію вашого об’єкта. 
Вони працюють, змінюючи те, як об’єкт показується та рендериться, а не 

саму геометрію, яку ви можете редагувати безпосередньо. Ви можете додавати 
кілька модифікаторів на один об’єкт для формування стеку, стосу модифікаторів 
– The Modifier Stack та застосовувати – Apply модифікатор, якщо ви бажаєте, 
щоб зміни, внесені ним, стали постійними. 

 
Меню модифікаторів. 
Вони можуть додаватися для активного об’єкта, використовуючи випадне 

меню «Додати Модифікатор» – Add Modifier вгорі їх вкладки властивостей. Нові 
модифікатори завжди додаються на низ стеку – stack (тобто, будуть 
застосовуватися останніми). 

Існує чотири типи модифікаторів: 
Модифікування – Modify 
Це засоби, подібні до типу деформування – Deform (дивіться нижче), 

проте, вони, зазвичай, не безпосередньо впливають на геометрію об’єкта, а деякі 
інші дані, такі як групи вершин. 

Генерування – Generate 
Це конструювальні/руйнувальні засоби, що будуть впливати на всю 

топологію – topology сіті. Вони можуть змінювати загальний вигляд об’єкта або 
додавати нову геометрію для нього… 

Деформування – Deform 
На відміну від типу Generate, вони лише змінюють форму об’єкта без 

змінювання його топології. 
Симулювання – Simulate 
Вони представляють симуляції фізики – physics simulations. У більшості 

випадків, вони автоматично додаються у стек модифікаторів всякий раз, коли 
вмикається Система Частинок – Particle System або симуляція Physics. Їх єдина 
роль – визначати позицію у стеку модифікаторів, з якого беруться базові дані для 
симуляції, яку вони представляють. Як такі, вони типово не мають жодних 
атрибутів та керуються уставами, що виставлені в окремих секціях Редактора 
Властивостей – Properties editor. 

Інтерфейс – Interface 



 
Розстава панелі (Subdivision Surface як приклад). 
Інтерфейс кожного модифікатора спільно використовує однакові базові 

компоненти, дивіться Ілюстрацію Розстава панелі (Subdivision Surface як 
приклад).. 

Вгорі знаходиться заголовок панелі. Іконки у ньому кожна представляють 
різні устави для модифікатора (зліва направо): 

Розгортання – Expand (іконка зі стрілкою вниз/управо) 
Згортання модифікатора дає показ тільки заголовку без опцій 

модифікатора. 
Тип – Type 
Іконка, як швидке візуальне орієнтування на тип модифікатора. 
Ім’я – Name 
Every modifier has a unique name per object. Two modifiers on one object must 

have unique names, but two modifiers on different objects can have the same name. 
The default name is based on the modifier type. 

Рендер – Render (іконка камери) 
Перемикається видимість ефекту модифікатора в рендері. 
Show in Viewport (screen icon) 
Перемикається видимість ефекту модифікатора в 3D Огляді. 
Показ у Режимі Редагування – Show in Edit Mode (іконка квадрата з 

вершин) 
Показується модифікована геометрія у режимі редагування Edit Mode, а 

також оригінальна геометрія, яку ви можете редагувати. 
Show on Cage (vertices-triangle icon) – Meshes only 
Залежно від попередньої устави, якщо увімкнено, модифікована геометрія 

може також редагуватися безпосередньо, замість оригінальної. 
Застосовується стек модифікаторів уверх цілком та включаючи той на 

керувальних точках кривої або поверхні, замість їх тесельованої геометрії. 
Примітка 
Стандартно, криві, тексти та поверхні завжди конвертуються у геометрію, 

подібну для сіті, перш ніж стек модифікаторів обчислюється на них. 
Переміщення – Move (кнопки з іконками стрілок уверх та вниз) 
Переміщується модифікатор уверх/вниз у стеку. 

Видалення – Delete (іконка X ) 

Видаляється цей модифікатор. 
Примітка 
Іконки квадрата – Square, трикутника – Triangle та поверхні 

– Surface можуть бути не доступні, залежно від типу об’єкта та модифікатора. 



Нижче заголовка є три кнопки: 
Застосування – Apply 
Робить модифікатор «реальним»: конвертує геометрію об’єкта для 

узгодження результатів застосованого модифікатора та видаляє цей 
модифікатор. 

Застосувати як Ключ Форми – Apply as Shape Key 
Зберігає результат цього модифікатора у новий відносний ключ форми 

– shape key. Це доступно лише з модифікаторами, що не впливають на топологію 
(типово, лише модифікатори типу Deform). 

Примітка 
Попри те, що це повинно працювати з будь-яким типом геометрії, що 

підтримує ключі форм, поточно це буде працювати лише із сітями. 
Копіювання – Copy 
Створює дублікат модифікатора зразу нижче поточного у стеку. 
Нижче цих заголовка і кнопок усі показувані опції будуть унікальними для 

кожного модифікатора. 
Стек модифікаторів – Modifier Stack 
Модифікатори – це серії не-руйнівних операцій, які можуть 

застосовуватися поверх геометрії об’єкта. Вони можуть застосовуватися 
практично у будь-якому порядку, обраному користувачем. 

Цей вид функціональності часто називається як «стек модифікаторів» – 
«modifier stack», і його часто можна знайти в кількох інших 3D застосунках. 

У стеку модифікаторів порядок, в якому модифікатори застосовуються, 
має вплив на результат. На щастя, модифікатори можуть легко 
переупорядковуватися клацанням на зручних іконках зі стрілками уверх та вниз. 
Наприклад, зображення нижче показує модифікатори Subdivision 
Surface та Mirror, які міняються місцями. 

Приклад Стеку Модифікаторів. 

 
Модифікатор Mirror є останнім 
елементом у стеку і результат 
виглядає як дві поверхні. 

 
Модифікатор Subdivision Surface є 
останнім елементом у стеку, і 
результатом є єдина злита 
поверхня. 

Модифікатори розраховуються зверху вниз у стеку. У цьому прикладі 
бажаний результат (справа) досягається шляхом, спершу, дзеркалення об’єкта, а 
потім, розрахування підподілення поверхні. 

Приклад – Example 



 
У цьому прикладі простий підподілений куб було трансформовано у 

досить складних об’єкт, використовуючи стек модифікаторів. 
 
 
7.1. Модифікатор «Дзеркалення» – Mirror Modifier 
Модифікатор Mirror дзеркалить сіть уздовж її локальних осей X, Y та/або 

Z, через Початок Об’єкта – Object Origin. Він може також використовувати 
інший об’єкт як центр дзеркалення, і далі використовувати локальні осі такого 
об’єкта замість власних. 

Опції – Options 

 
Модифікатор «Дзеркалення» – Mirror. 
Вісь – Axis 
Вісь X, Y, Z, уздовж якої здійснюється дзеркалення, тобто, вісь, 

перпендикулярна симетрії площини дзеркалення. 
Щоб зрозуміти, як дана вісь застосовується до напрямку дзеркалення, якщо 

ви були до дзеркалення на осі X, то додатні значення по X оригінальної сіті 
стануть від’ємними значеннями по X віддзеркаленої сторони. 



Ви можете вибирати більше, ніж одну з цих осей. І потім отримуватимете 
більше дзеркалених копій. З однією віссю ви отримуєте одиничне дзеркалення, з 
двома осями – чотири дзеркалення, а з усіма трьома осями – вісім дзеркалень. 

Половинення – Bisect 
Якщо сіть є вже на обох сторонах площини дзеркалення, то вона 

розрізається такою площиною, і лише одна сторона (стандартно «негативна») 
зберігається для здійснення процесу дзеркалення. 

Переверт – Flip 
Коли Bisect увімкнено на осі, ви можете використовувати цю уставу для 

перемикання збереженої та дзеркаленої сторони (тобто, коли це увімкнено, 
«позитивна» сторона буде зберігатися, замість «негативної»). 

Об’єкт Дзеркалення – Mirror Object 
Вибірник об’єкта – Object Selector для вибору об’єкта (зазвичай, порожні), 

чиї позиція та обертання буде використовуватися для визначення площин 
дзеркалення (замість використовування тих з модифікованого об’єкта). 

Ви можете анімувати це для анімування ефекту дзеркалення. 
Групи Вершин – Vertex Groups 
Намагається дзеркалити наявні групи вершин. 
Дуже гарна функція, але така, що має дуже специфічні передумови: 
 Групи вершин, які ви хочете дзеркалити, повинні іменуватися 

відповідно до звичайного патерну «ліво/право» (тобто, із суфіксом на кшталт 
«.R», «.right», «.L» тощо). 

 Група вершин на дзеркаленій стороні повинна вже існувати (вона не 
буде створюватися автоматично). Також вона повинна бути повністю 
порожньою (без жодних вершин, призначених в неї). 

Злиття – Merge 
Коли вершина знаходиться у тому ж місці (у межах відстані заданої Merge 

Limit), що і її дзеркалення, то вона буде злита з цією дзеркаленою вершиною. 
Ліміт Злиття – Merge Limit 
Максимальна відстань між вершиною та її дзеркальною копією, при якій 

вони будуть злиті (будучи підхопленими до площини дзеркалення). Потребує 
увімкнення Merge. 

Відсікання – Clipping 
Запобігає переміщуванню вершин крізь площину(и) дзеркалення, коли 

користувач трансформує їх у режимі редагування Edit Mode. 
Якщо це увімкнено, але вершини знаходяться поза площиною дзеркалення 

і за межами Merge Limit такі вершини не будуть злиті. Але, як тільки, ці вершини 
є у межах Merge Limit, то вони підхопляться одна до одної та не зможуть 
переміщуватися поза площиною дзеркалення. 

Примітка 
Вершини на площині дзеркалення будуть не у змозі переміщатися від неї 

при увімкненій Clipping. Ви повинні вимкнути це, щоб могти переміщати 
вершини по осі дзеркалення знову. 

Переверт UV – Flip UV 
Опції Flip U та Flip V дозволяють вам дзеркалити координати текстури UV 

через середину зображення. 
Наприклад, якщо ви маєте вершину з координатами UV (0.3, 0.9), то її 



дзеркальна копія буде мати координати UV (0.7, 0.1). 
Зсуви UV – UV Offsets 
Величина зсування дзеркалених UVт на осях U/V. 
Це корисно для запікання (оскільки перекривні UVи можуть спричиняти 

артефакти, що з’являються на запеченій розкладці), тому ці UVи можуть бути 
переміщені назовні зображення і не використовуватися для запікання, але все ще 
використовуватися для показу. 

Поради – Hints 
Багато завдань моделювання передбачають створення об’єктів, що є 

симетричними. Це модифікатор пропонує простий та ефективний спосіб робити 
це, з оновленням дзеркалення у реальному часі, як ви редагуєте його. Після того, 
як ваше моделювання завершене, ви можете клацнути на кнопці Apply для 
зроблення реальної версії вашої сіті або залишити модифікатор не застосованим 
для майбутнього редагування. 

Точне Розміщення Площини Дзеркалення – Accurately Positioning the 
Mirror Plane 

Для застосування модифікатора Mirror зазвичай потрібно перемістити 
початок об’єкта на ребро або грань, що буде віссю для дзеркалення. Це може 
бути складно намагатися робити на око. 

Доброю технікою для досягнення точної позиції є вибрати таке ребро, 
потім підхопити курсор до вибрання – snap Cursor to Selection. Це розмістить 
позицію 3D Курсора у центрі цього ребра. Наостанок, скористайтеся меню 
«Задати Початок» – Set Origin та виберіть «Початок до 3D Курсора» – Origin to 
3D Cursor. Це перемістить початок об’єкта (і звідси, площину дзеркалення) на 
місце, де розміщується 3D курсор, а дзеркалення буде точним. 

Альтернативою цьому є використання порожні як об’єкта 
дзеркалення Mirror Object, який ви поміщаєте у коректну позицію. 

7.2. Модифікатор «Масив» – Array Modifier 
Модифікатор Array створює масив копій базового об’єкта, кожна копія 

якого зсувається від попередньої на певну відстань одним з можливих способів. 
Вершини у суміжних копіях можуть бути злити, якщо вони поруч, дозволяючи 
генерувати згладження модифікатором «Підподілення Поверхні» – Subdivision 
Surface. 

Цей модифікатор може бути корисним при комбінуванні плитко-здатних 
сітей для швидкого розроблення великих сцен. Він також корисний для 
створення повторюваних форм. 

Одночасно кілька модифікаторів Array можуть бути активними для об’єкта 
(наприклад, для створення складних тривимірних конструкцій). 

Опції – Options 



 
Модифікатор «Масив» – Array. 
Тип Припасування – Fit Type 
Керує тим, як визначається довжина масиву. Існує три варіанти, що 

активують відповідно показ устав Curve, Length або Count, що пояснюються 
нижче: 

Крива Припасування – Fit Curve 
Генерує достатньо копій для вписування у межах довжини об’єкта кривої, 

визначеного уставою Curve. 
Довжина Припасування – Fit Length 
Генерує достатньо копій для вписування у межах довжини об’єкта кривої, 

визначеного уставою Length. 
Фіксований Рахунок – Fixed Count 
Генерує кількість копій, визначених уставою Count. 
Примітка 
 Обидві Fit Curve та Fit Length використовують локальну систему 

координат для розміру базового об’єкта, а це означає, що масштабування 
базового об’єкта у режимі об’єкта Object Mode не буде змінювати кількість 
копій, генерованих цим модифікатором. 

 Fit Length використовує локальну систему координат для довжини 
кривої, і це означає, що масштабування кривої у режимі об’єкта Object Mode не 
буде змінювати кількість копій, генерованих цим модифікатором. 

 Applying – застосовування масштабу може бути корисним для обох. 
Зсув – Offset 
Постійний Зсув – Constant Offset, X, Y, Z 
Додає постійний компонент пересування для зсуву дубльованих об’єктів. 

Можуть бути визначені постійні компоненти по X, Y та Z. 
Відносний Зсув – Relative Offset, X, Y, Z 
Додає пересування, рівне розміру габаритної коробки об’єкта уздовж 

кожної осі, множене на фактор масштабування, для зсуву. Можуть бути 
визначені фактори масштабування по X, Y та Z. 



 
Приклад Відносного зсуву (0.5, 1.0 та 1.5). 
Зсув Об’єктом – Object Offset 
Додає трансформацію, взяту із заданого об’єкта (відносно поточного 

об’єкта), для зсуву. Доброю практикою є використання об’єкта порожні, 
центрованої по або близько початкового об’єкта. Наприклад, обертаючи цю 
порожню, можна створити коло або спіраль об’єктів. 

 
Приклад Зсуву Об’єктом. 
Злиття – Merge 
Злиття – Merge 
Якщо увімкнено, то вершини у кожній копії будуть злиті з вершинами у 

наступній копії, у межах заданої Distance. 
Перше й Останнє – First Last 
Якщо увімкнено та Merge увімкнено, то вершини у першій копії будуть 

злиті з вершинами в останній копії, знову ж таки якщо вони є у 
діапазоні Distance. Це корисно для кругових об’єктів. 

Приклад злиття з First Last. 



 
Розрив підподілення 
спричиняється не зливанням 
вершин між першою та 
останньою копіями (First 
Last вимк). 

 
Розрив підподілення усунуто 
зливанням вершин між першою 
та останньою копіями (First 
Last увім). 

Відстань – Distance 
Керує відстанню злиття для Merge та First Last. 
UVи – UVs 
Зсув U, Зсув V – U Offset, V Offset 
Зсуває UVи для кожного нового дубліката на встановлену величину. 
Торець – Cap 
Торець Старту / Торець Кінця – Start Cap / End Cap 
Це дозволяє на кінцях масиву мати різні сіті. 
Для початку: ніби він був у позиції -1, тобто, на один «крок масиву» перед 

першою «звичайною» копією масиву. Для кінця: ніби він був у позиції n + 1, 
тобто, на один «крок масиву» після останньої «звичайної» копії масиву. 

При активованій Merge та вершини торця є у межах порогу Distance, то 
вони будуть злиті. 

Примітка 
Об’єкти торців старту/кінця поточно не підтримують опцію First Last. 
Поради – Hints 
Розрахунок Зсуву – Offset Calculation 
Трансформація, застосовувана від однієї копії до наступної, 

розраховується як сума трьох різних компонентів (Relative, Constant and Object), 
кожна з яки може бути увімкнена/вимкнено незалежно від інших. Це дозволяє, 
наприклад, відносний зсув (1.0, 0.0, 0.0) та постійний зсув (0.1, 0.0, 0.0), що дає 
масив об’єктів акуратно розміщений уздовж осі X з постійним 0.1 між ними, 
маючи оригінальний розмір об’єкта. 

Приклади – Examples 



 
Ланцюг, створений з одиничної ланки. Sample blend-file. 

 
Щупальце, створене за допомогою модифікатора Array Modifier, за яким 

слідує модифікатор Curve. 
Сегмент на передньоплані – це базова сіть для щупальця; щупальце 

торцоване двома спеціально модельованими об’єктами, деформованими одним і 
тим же об’єктом кривої як головна частина щупальця. Sample blend-file. 

Фрактал – Fractal 

 
Багаторівневий масив, анімований 
з допомогою розмиву руху. 

 
Фрактал, створений за допомогою 
одночасно кількох масивів. Sample 
blend-file. 



7.3. Модифікатор «Скіс» – Bevel Modifier 
Модифікатор Bevel скошує ребра сіті, до якої він застосовується, з деяким 

керуванням тим, як і де цей скіс застосовується на цій сіті. 
Він не-руйнівна альтернатива операції Bevel Operation у Режимі 

Редагування – Edit Mode. 

Огляди збоку для куба. 

 
Не скошено. 

 
Скошено. 

Опції – Options 

 
Модифікатор «Скіс» – Bevel. 
Ширина – Width 
Розмір ефекту скосу. Дивіться нижче Width Method. 



 
Три Куби з шириною скосу як 0.1, 0.3 та 0.5. 
Сегменти – Segments 
Кількість петель ребер, доданих уздовж грані скосу. 
Профіль – Profile 
Форма скосу від угнутої до вигнутої. Він немає жодного впливу, 

якщо Segments мають значення, менше ніж 2. 
Material – Матеріал 
Індекс гнізда матеріалу, що використовується для скосу. Коли задано -1, то 

буде використано матеріал, найближчої оригінальної грані. 
Лише Вершини – Only Vertices 
При увімкненні, лише області біля вершин скошуються; ребра 

залишаються без змін. 

 
Три куби з шириною скосу як 0.1, 0.3 та 0.5 та увімкненою опцією Only 

Vertices. 
Затиск Перекриття – Clamp Overlap 
Лімітує ширину кожного скошеного ребра так, що ребра не можуть 

спричиняти перекривні перетини з іншою геометрією. 
Ковзання Петлі – Loop Slide 
Якщо є нескошені ребра уздовж скошених ребер на вершині, то скіс 

намагатиметься ковзати уздовж цих ребер, при можливості. Вимикання цієї опції 
може призвести до більш рівномірних ширин скосу. 



Позначити Шви – Mark Seams 
Якщо ребро зі швом перетинається з ребром без шва і ви скошуєте їх разом, 

то ця опція буде підтримувати очікуване поширення швів. 
Позначити Гостроту – Mark Sharp 
Подібно до Mark Seams, але для гострих ребер. 
Жорсткіші Нормалі – Harden Normals 
При увімкненні нормалі граней для кожної вершини скошених граней 

наладнуються так, щоб узгоджуватися з навколишніми гранями, а нормалі 
навколишніх граней не задіюються. Це буде утримувати навколишні грані 
плоскими (якщо вони були такими перед цим), при цьому відтінення граней 
скосу плавно переходитиме в них. Для роботи цього ефекту вам необхідні дані 
кастомних нормалей, які вимагають увімкнення опції «Авто Згладження» – Auto 
Smooth (дивіться Normals). 

Метод Ліміту – Limit Method 
Використовується для керування тим, де скіс застосовується до сіті. 
Нема – None 
Без ліміту, усі ребра будуть скошені. 
Кут – Angle 
Лише ребра, де суміжні грані формують кут, менший за визначений, 

будуть скошені. Призначено для того, щоб дозволити вам скошувати тільки 
гострі ребра об’єкта без впливу на його згладжені поверхні. 

Вагомість – Weight 
Використовує вагомість скосу кожного ребра для визначення ширини 

скосу. Коли ця вагомість скосу є 0.0, то скіс не застосовується. Дивіться про 
коригування вагомостей скосу тут – here. 

Група Вершин – Vertex Group 
Використовує вагомості з групи вершин для визначення ширини скосу. 

Коли вагомість вершини є 0.0, то скіс не застосовується. Ребро буде скошене 
тільки тоді, коли обидві його вершини входять у вказану групу вершин. Дивіться 
про наладжування вагомостей груп вершин тут – here. 

Метод Ширини – Width Method 
Визначає те, як тлумачиться Width для визначення величини скосу. 

 
Методи ширини. 
Зсув – Offset 
Значення тлумачиться як відстань від оригінального ребра до ребра 

скошеної грані. 



Ширина – Width 
Значення інтерпретується як відстань між двома новими ребрами, 

формованими скосом. 
Глибина – Depth 
Значення - це відстань перпендикуляра від нової скошеної грані до 

оригінального ребра. 
Відсоток – Percent 
Подібно до Offset, але значення тлумачиться як відсоток довжини 

суміжного ребра. 
Задати Режим Сили Грані – Set Face Strength Mode 
Задається Face Strength на гранях, що задіяні у скосі, відповідно до 

режиму, визначеного тут. Це може використовуватися у поєднанні з наступним 
модифікатором Weighted Normals (з увімкненою опцією Face Influence). 

Нема – None 
Не задається сила грані. 
Нове – New 
Задається сила грані нових граней уздовж ребер на «Середньо» – Medium, 

і сила граней нових граней у вершинах на «Слабко» – Weak. 
Задіяне – Affected 
На додаток до тих, що задані у випадку New, також задається для граней, 

суміжних до нових граней, сила Strong. 
All – Усе 
На додаток до тих, що задані для опції Affected, також задається для всіх 

інших граней моделі сила Strong. 
Патерни Мітерів – Miter Patterns 
Мітер – miter формується, коли два скошені ребра зустрічаються під кутом. 

На одній стороні, де кут є більшим ніж 180 градусів, якщо такий є, це називається 
«мітер зовні» – outer miter. Якщо він менше ніж 180 градусів, то він називається 
«мітер ізсередини» – inner miter. Мітери зовні та ізсередини можуть кожен бути 
задані з одним з цих патернів: 

Гостро – Sharp 
Ребра зустрічаються у точці під гострим кутом без жодних добавних 

вершин, уведених на ребрах. 
Латка – Patch 
Ребра зустрічаються у точці під гострим кутом, але на додаток дві 

додаткові вершини уводяться біля цієї точки так, щоб ребра і грані у цій вершині 
менше защемлювалися, ніж це відбувається у випадку з Sharp. Цей патерн не має 
сенсу для мітерів ізсередини, тому він поводиться як Arc для них. 

Повзунок «Розтікання» – Spread керує тим, як далеко ці нові вершини 
знаходяться від точки зустрічання. 

Дуга – Arc 
Дві вершини уводяться біля точки зустрічання і вигнута дуга сполучає їх 

між собою. 
Повзунок «Розтікання» – Spread керує тим, як далеко ці нові вершини 

знаходяться від точки зустрічання. 
Повзунок «Профіль» – Profile керує формою цієї дуги. 



Діаграми патернів мітерів. 

 
Мітер зовні гостро. 

 
Мітер зовні 
латкою. 

 
Мітер зовні 
дугою. 

 
Мітер ізсередини 
гостро. 

 
Мітер ізсередини 
дугою.  

Розтікання – Spread 
Значення, використовуване для розтікання добавних вершини, окрім не-

гострих мітерів. 
Метод Перетину – Intersection Method 
Коли більш, ніж два скошених ребра зустрічаються на вершині, то 

створюється сіть як спосіб завершити перетин між генерованою геометрією. Ця 
опція керує методом, що використовується для створення такої сіті. 

Заповнити Сіткою – Grid Fill 
Стандартний метод для будування перетинів, корисний, коли бажане 

плавне продовження профілю скосу. Без увімкненої Custom Profile, крива 
профілю продовжується через перетин, але з кастомним профілем він просто 
створює плавну сітку у межах рубежу перетину. 

Відріз – Cutoff 
Створює відріз грані у кінці кожного скошеного ребра, що входить у 

вершину. Це найбільш корисно для кастомних профілів, коли новий перетин є 
надто складним для плавного заповнення сіткою. 

При тристоронньому перетині, коли кутки ізсередини профілів відрізу 
граней зустрічаються у тій самій локації, жодна центральна грань не 
створюється. 

Напрямок відрізу граней залежить від нормалі оригінальної вершини. 

Опції методу перетину. 



 
Метод 

перетину 
заповнення сіткою. 

 
Тристоронній 

відріз перетину, де 
вершини ізсередини 
зливаються. 

 
Відріз методу 

перетину з 
центральною 
гранню. 

Кастомний Профіль – Custom Profile 

 
Віджет кастомного профілю. 
Цей віджет дозволяє створення визначеного користувачем профілю з 

більшою складністю, ніж з одиничним параметром профілю. Модальний засіб 
дозволяє перемикати кастомний профіль, але форма цього профілю здатна 
редагуватися у панелі опцій після того, як операція підтверджена. 

Профіль починається внизу справа віджета та закінчується вгорі зліва, ніби 
він знаходився між двома ребрами, що зустрічаються. Керувальні точки 
створюються у віджеті й потім шлях відбирається з кількістю сегментів з 
модифікатора скосу. 

Передустави – Presets 
Передустави «Петлі Підтримки» – Support Loops та «Кроки» 

– Steps будуються динамічно залежно від кількості сегментів у скосі. Якщо 
кількість скосів змінюється, то передустава має бути застосована повторно. 

Розворот – Reverse 
Кнопка Reverse перевертає орієнтацію профілю для всіх скошених ребер. 
Відсікання – Clipping 



Перемикач Clipping дозволяє переміщувати керувальні точки поза 
початковим рубежем, надаючи змогу скосу додавати об’єм у сіть, а не просто 
вилучати його. 

Примітка 
Повзунок Profile все ще корисний, коли мітери увімкнені, оскільки він все 

ще керує формою профілю мітера. 
Відбір – Sampling 
Вибірки будуть спершу додаватися до кожної керувальної точки, потім, 

якщо достатньо вибірок, то вони будуть розподілятися рівномірно між ребрами. 
Опція «Вибірка Прямих Ребер» – Sample Straight Edges перемикає, чи вибірки 
додаються до ребер з гострими керувальними точками на обох боках. Якщо не 
достатньо вибірок, щоб дати кожному ребру однакову кількість вибірок, то вони 
просто будуть додані до найменш вигнутих ребер, тому рекомендується 
використовувати принаймні стільки ж сегментів, скільки є керувальних точок. 

 
 
8. Ліплення. 
Ліплення та малювання використовує пензлі – brushes для малювання 

безпосередньо на сітях. Існують кілька режимів – modes, що використовують 
це. 

 Sculpting – ліплення: змінюється топологія сіті. 
 Vertex Paint – малювання вершин: змінюється колір вершин в 

активному шарі кольорів вершин. 
 Weight Paint – малювання вагомостей: Змінюються вагомості 

вершин в активній групі вершин. 
 Texture Paint – малювання текстур: Змінюються пікселі активної 

текстури зображення. 
 
Sculpt Mode – Режим Ліплення подібний до Режиму Редагування – Edit 

Mode у тому, що він використовується для зміни форми моделі, однак, Режим 
Ліплення користається іншим ходом роботи: замість оброблення 
індивідуальних елементів (вершин, ребер та граней) область моделі змінюється 
за допомогою пензля. Іншими словами, замість вибирання групи вершин, 
Режим Ліплення маніпулює геометрією у регіоні впливу пензля. 

 
Приклад режиму скульптури. 
Режим Ліплення – Sculpt Mode 
Режим скульптури вибирається в меню режимів заголовка 3D-вигляду. 



Після активації режиму скульптури панель інструментів 3D-вигляду зміниться 
на панелі, специфічні для режиму скульптури. З’явиться червоне коло, яке 
відображатиме положення курсора в 3D-вигляді. 

Примітка 
Щоб мати передбачувану поведінку пензля, застосуйте масштаб (Apply > 

Scale) вашої сіті. 
Пензель 
У режимі «Ліплення» використовується подібний пензель до 

інших режимів малювання , але він трохи просунутіший. Усі звичайні елементи 
керування пензлем все ще застосовуються, і він функціонує точно так само, 
проте пензель для ліплення відображається у 3D. Це означає, що пензель 
повторюватиме контури сітки, а радіус відображається шляхом орієнтації 
пензля відповідно до нормалі сітки . Наскільки точно курсор повторює 
кривизну сітки, можна змінити в налаштуваннях пензля . 

Пензель також може змінюватися залежно від поточного 
активного інструменту , щоб краще відобразити, як цей інструмент працює. 

7.1. Засоби Ліплення – Sculpting Tools 

Рисування – Draw X  

Переміщує вершини всередину або назовні, базуючись на 
усередненій нормалі вершин, що вміщуються у межах 
нарисованого штриха пензля. 

Намалюй чітко 
Однак, подібно до пензля «Малювання », він деформує 

сітку відносно початкових координат і використовує 
параметр «Чіткіший спад» . Це корисно для створення зморшок 
на тканині, стилізованого волосся або чітких країв поверхні. 

Глина C  

Подібно до пензля Draw, але включає устави для 
коригування площини, на якій пензель діє. Він поводиться як 
комбінація пензлів Flatten та Draw. 

Смужки Глини – Clay Strips 
Подібно до пензля Clay, але вживає куб для визначення 

області впливу пензля, а не сферу. 

Куля – Layer L  

Цей пензель подібний до Draw, за винятком того, що 
висота зміщення шару обмежена. Це створює вигляд суцільного 
шару при рисуванні. Цей пензель не рисує поверх себе; штрих 
пензля само перетинається. Відпуск кнопки миші та починання 
нового штриха скине глибину та дасть малювання поверх 
попереднього штриха. 

Стало – Persistent 
Ви можете продовжувати ліплення на тому ж шарі між 

штрихами, коли це увімкнено. 
Задати Базу Сталості – Set Persistent Base 
Ця кнопка скидає базу так, що ви можете додавати інший шар. 



Надути I  

Подібно до Draw, за винятком того, що вершини у 
режимі Inflate зміщуються у напрямку своїх нормалей. 

Кулька – Blob 
Розміщує сітку назовні або всередину, надаючи їй сферичну форму, з 

налаштуваннями для керування ступенем збільшення на краю сфери. 

Складка – Crease Shift-C  

Створює різкі вдавлення або видавлення, уштовхуючи або виштовхуючи 
сіть, одночасно прищемляючи вершини. 

Згладження – Smooth S  

Як випливає з назви, усуває нерівності на ділянці сіті у межах впливу 
пензля шляхом згладження позицій вершин. 

Згладити Shift-T  

Пензель Flatten визначає «площину області», розміщену стандартно в 
усередненій висоті вище/нижче вершин у межах області цього пензля. Вершини 
далі виштовхуються у напрямку цієї площини. Інверсією пензля Flatten є 
пензель Contrast, який штовхає вершини уверх чи вниз від цієї площини пензля. 

Заповнити 
Працює як пензель «Згладити», але лише переміщує вершини нижче 

площини пензля вгору. 
Інвертувати для скребання 

Коли ввімкнено, утримання Ctrl під час ліплення змінює поведінку 

пензля на таку ж, як і пензель «Скраб ». Коли вимкнено, утримання Ctrl під час 

ліплення призведе до зміщення вершин під курсором вниз. 
Скрейп 
Пензель «Скраб» працює аналогічно пензлю «Згладити» , але переміщує 

вниз лише вершини над площиною. 
Інвертувати для заповнення 

Коли ввімкнено, утримання Ctrl під час ліплення змінює поведінку 

пензля на таку ж, як і пензель заповнення . Коли вимкнено, утримання Ctrl під 

час ліплення призведе до відсунення вершин над курсором вгору від курсора. 
Багатоплощинний скребок 
Скребає сітку двома кутовими площинами одночасно, створюючи 

гострий край між ними. Це корисно для створення країв під час ліплення 
об'єктів з твердою поверхнею. 

Кут площини 

Кут між двома площинами пензля, натискання Ctrl інвертує кут. 

Динамічний режим 
Коли ця функція ввімкнена, кут основи вибирається з поверхні сітки. Кут 

площини контролює, наскільки кут збільшиться під час застосування тиску 

пера. При натисканні Ctrl кут площини фіксується на рівні 0 градусів. 

Показати попередній перегляд курсора 
Відображає попередній перегляд двох площин скребання та кута, який 



вони утворюють, замість курсора під час виконання обведення. 

Щіпка P  

Виштовхує вершини у напрямку центра пензля. Інверсна устава 
розщемлення Magnify, в якому вершини уштовхуються від центру пензля. 

Захопити G  

Використовується для перетягування групи точок. На відміну від інших 
пензлів, Grab не модифікує різні точки, оскільки він перетягує їх по моделі. 
Натомість, Grab вибирає групу вершин при натиску кнопки миші та тягне їх 
слідувати за мишею. Його вплив подібний до рухання групи вершин у режимі 
редагування Edit Mode з увімкненим пропорційним редагуванням Proportional 
Editing, за винятком того, що Grab може використовувати інші опції режиму 
ліплення Sculpt Mode (як текстури та симетрія). 

Зміїний Гак – Snake Hook K  

Виштовхує вершини вздовж руху пензля для створення довгих, 
змієподібних форм. 

Збільшити 
Пензель «Зміїний гачок» має тенденцію втрачати об’єм під час мазка, зі 

значенням збільшення більше 0,5 можна ліпити фігури без втрати об’єму. 
Гребінка – Rake 
Фактор для підтримки переміщування сіті з обертанням, що слідує за 

рухом курсора. 
Палюх – Thumb 
Подібно до пензля Nudge, він сплощує сіть в області пензля, одночасно 

рухаючи її у напрямку штриха пензля. 
Поза 
Цей пензель використовується для позиціонування моделі, що імітує 

деформацію, подібну до арматури. Точка повороту для обертання 
розраховується автоматично на основі радіуса пензля та топології моделі. При 

натисканні Ctrl , пензель позиціонування застосовує обертання з поворотом до 

сегментів позиціонування замість використання обертання або IK-деформації. 
Зниження обертання на кількох сегментах контролюється кривою спаду пензля. 

Зсув початку пози 
Зміщення початку пози відносно радіуса пензля. Це корисно для 

маніпулювання областями з багатьма складними формами, такими як пальці. 
Плавні ітерації 
Контролює плавність спаду деформації. 
Сегменти Pose IK 
Контролює, скільки IK кісток буде створено для позування. 
Підштовх – Nudge 
Переміщує вершини у напрямку штриха пензля. 
Оберт – Rotate 
Обертає вершини у межах пензля у напрямку руху курсора. Початковий 

напрямок перетягнення є нульовим кутом і, обертаючи навколо центру, ви 
можете створювати ефект вихору. 

Слайд Релакс 



Цей пензель ковзає топологію сітки в напрямку штриха, не змінюючи 

геометричної форми сітки. При натисканні Shift пензель переходить у 

режим релаксації , який намагається створити рівномірний розподіл 
квадрицепсів без деформації об'єму сітки. 

Спрощення – Simplify 
Цей пензель стягує короткі ребра (як визначено розміром деталізації), 

незалежно від того чи увімкнена опція Collapse Short Edges. Цей пензель не діє, 
якщо не увімкнена динамічна топологія. 

Маска – Mask M  

Дозволяє вам вибирати частини сіті, на які не повинні мати вплив інші 
пензля, шляхом малювання кольорів вершин. Значення маски показуються 
відтінками сірого. Тобто, чим темнішою маскована область є, тим менший 
вплив на неї має ліплення. Дивіться також про опції меню Маска – Mask. 

Засіб Маски – Mask Tool 
Пензель маски має два режими: 
Рисування – Draw 
Рисується маска. 

Згладження – Smooth Shift  

Натискання Shift  при активному пензлі «Маска» перемикатиме маску у 

режим згладження. 
Сітчастий фільтр 
Все 
Тип фільтра 
Розслабтеся 
Намагається створити рівномірний розподіл квадрицепсів без деформації 

об'єму сітки. Це працює так само, як і режим Relax пензля Slide Relax . 
Анотування – Annotate 
Рисується анотація від руки. 
Лінія Анотування – Annotate Line 
Рисується анотація у вигляді прямої лінії. 
Полігон Анотування – Annotate Polygon 
Рисується анотація у вигляді полігона. 
Стирач Анотування – Annotate Eraser 
Стираються попередньо нарисовані анотації. 
7.2. Адаптивне Ліплення – Adaptive Sculpting 
Для того, щоб для ліплення отримувати точні та передбачувані результати, 

Blender потребує геометрію, з якою йому працювати. Одним зі способів 
домогтися цього - починати з високо підподіленої сіті. Інший спосіб передбачає 
використовування одного з двох адаптивних методів ліплення для додання 
геометрії динамічно. 

Динамічна Топологія – Dynamic Topology 
Динамічна топологія (англійською «dyntopo» скорочено від «dynamic 

topology») – це метод динамічної теселяції (коміркування – підподіл поверхні 
на комірки) при ліпленні, що додає та вилучає деталі під пензлем. Це працює 
шляхом спершу теселювання сіті, потім накладання штриха ліплення поверх 



тесельованої сіті. 
Це дає змогу виліплювати складні форми з простої сіті, а не тільки просто 

додавати деталі на змодельовану базову сіть. 
Модифікатор «Багатороздільність» – Multiresolution Modifier 
Модифікатор Multiresolution можна використовувати для динамічного 

поділу сітки. Чим більше поділів, тим більше обчислень потрібно. Завдяки 
неруйнівному стеку даних Blender, багатороздільне ліплення допоможе, коли у 
вас є чиста топологічна базова сітка. 

Під час ліплення з кількома роздільними здатностями ви маєте 
можливість ліпити на різних рівнях поділу, це означає, що ви можете ліпити 
деякі деталі на рівні поділу 1, додавати більше деталей до поділу 2 та 
повертатися до поділу 1, виправляючи деякі помилки. Хоча цей робочий процес 
часто використовується, модифікатор багатороздільної здатності має деякі 
обмеження. Ви можете отримати деякі спотворення сітки. Як порада, додайте 
якомога більше деталей, перш ніж додавати більше поділів. Глиняний пензель 
краще працює зі ліпленням з кількома роздільними здатностями для ліплення 
вторинних форм. 

 Перехід уверх на один рівень багатороздільності – PageUp  

 Перехід вниз на один рівень багатороздільності – PageDown  

 Задання рівня багатороздільності – від Ctrl-0  до Ctrl-5  

Ховання і Маскування – Hiding & Masking 
Орієнтир – Reference 
Режим – Mode 
Режим Ліплення – Sculpt Mode 
Меню – Menu 

«Ліплення» – Sculpt  

При ліпленні області можуть ховатися позаду частин сіті або вони 
можуть бути надто близько до інших частин. Для роботи з ними корисно 
ізолювати частини сіті для ліплення по них. Це може бути зроблено шляхом або 
повністю ховання частин сіті, або маскування областей, на яких не можна буде 
ліпити. 

Схов – Hide 
Частини сіті можуть бути сховані у Режимі Ліплення для підвищення 

продуктивності оглядвікна та для доступу до частин сіті, до яких інакше було б 
важко доступитися, оскільки вони загороджені іншими частинами. 

На сховані грані не діють засоби ліплення. Ховання спільно 
використовується для Режиму Правки – Edit Mode та Режиму Ліплення – Sculpt 
Mode (тобто, ховання/знеховання в одному автоматично задіюється так само в 
іншому). 

Показ Усе – Show All Alt-H  

Вмикається показ усіх схованих частин. 

Схов Габаритною Коробкою – Hide Bounding Box H  

Ховає частину сіті всередині вибрання. Це працює подібно до вибору 
коробкою Box Select tool. 



Показ Габаритною Коробкою – Show Bounding Box Shift-H  

Вмикається показ схованої частини сіті всередині вибрання. 
Сховати Масковане – Hide Masked 
Ховає усі масковані вершини. 
Маска – Mask 
Маскування для керування тим, які області сіті будуть підпадати під 

вплив ліплення. 

 
Чорні частини є маскованими. 
Пензель – Brush 
Для того, щоб відредагувати маску, виберіть пензель «Маска» – Mask 

Brush на панелі «Пензель» – Brush. 
Редагування – Editing 
Маски можуть редагуватися по всій моделі: 

Інвертувати Маску – Invert Mask Ctrl-I  

Інвертує наявну маску. 
Заповнити Маскою – Fill Mask 
Заповнює все маскою зі значенням 1. 

Зчистити Маску – Clear Mask Alt-M  

Заповнює маскою зі значенням 0. Про вилучення повністю даних маски 
дивіться Clearing Mask Data. 

Маска Коробкою – Box Mask B  

Працює подібно до засобу вибір коробкою Box Select, це створює 

прямокутний маскувальний регіон. Утримуйте Shift  для зчищення маски 

вибраного регіону. 

Маска Ласо – Lasso Mask Shift-Ctrl-LMB  

Може використовуватися для створення довільної форми маски, подібно 
до засобу Lasso Select. 

Порада 
Для зчищення маски областей за допомогою засобу Lasso Mask спершу 

інвертуйте цю маску, застосуйте Lasso Mask, а потім інвертуйте цю маску 
назад. 

Mask Slice 
Removes the masked vertices from the mesh. 
Threshold 



Minimum mask value to consider the vertex valid to extract a face from the 
original mesh 

Fill Holes 
Fills concave holes with geometry that might have resulted from the Mask 

Slice operation. 
Slice to New Object 
Create a new object from the masked geometry. 
Показування – Displaying 
Орієнтир – Reference 
Режим – Mode 
Режим Ліплення – Sculpt Mode 
Випливне – Popover 

«Накладки Оглядвікна > Ліплення > Маска» – Viewport Overlays – Sculpt  

‣ Mask  

Показ маски може перемикатися як накладка оглядвікна – viewport 
overlay. У випливному накладок безпрозорість накладки маски може 
налагоджуватися, щоб робити її більш чи менш видимою на сіті. 

Зчищання Даних Маски – Clearing Mask Data 
Орієнтир – Reference 
Режим – Mode 
Режим Об’єкта/Редагування – Object/Edit Mode 
Меню – Menu 
«Властивості > Дані Об’єкта > Дані Геометрії > Зчистити Дані Маски 

Ліплення» – Properties ‣ Object Data ‣ Geometry Data ‣ Clear Sculpt-Mask Data  

Повністю вивільняє шар даних маски із сіті, хоча це і не є величезною 
користю, але це може пришвидшити ліплення, якщо така маска більше не 
використовується. 
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